
 

Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706 
USA
http://www.cisco.com
Tel: 408 526-4000

800 553-NETS (6387)
Fax: 408 526-4100

Cisco Voice Services Provisioning 
Tool Release 1.6 User’s Guide

November 30, 2001

Text Part Number: OL-1349-01



 

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT 
NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE 
PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR 
APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION 
PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO 
LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of 
UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California. 

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED 
“AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, 
INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR 
INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

AccessPath, AtmDirector, Browse with Me, CCIP, CCSI, CD-PAC, CiscoLink, the Cisco Powered Network logo, Cisco Systems Networking Academy, 
the Cisco Systems Networking Academy logo, Fast Step, Follow Me Browsing, FormShare, FrameShare, GigaStack, IGX, Internet Quotient, IP/VC, iQ 
Breakthrough, iQ Expertise, iQ FastTrack, the iQ Logo, iQ Net Readiness Scorecard, MGX, the Networkers logo, Packet, RateMUX, ScriptBuilder, 
ScriptShare, SlideCast, SMARTnet, TransPath, Unity, Voice LAN, Wavelength Router, and WebViewer are trademarks of Cisco Systems, Inc.; Changing 
the Way We Work, Live, Play, and Learn, Discover All That’s Possible, and Empowering the Internet Generation, are service marks of Cisco Systems, 
Inc.; and Aironet, ASIST, BPX, Catalyst, CCDA, CCDP, CCIE, CCNA, CCNP, Cisco, the Cisco Certified Internetwork Expert logo, Cisco IOS, the Cisco 
IOS logo, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Enterprise/Solver, EtherChannel, EtherSwitch, FastHub, 
FastSwitch, IOS, IP/TV, LightStream, MICA, Network Registrar, PIX, Post-Routing, Pre-Routing, Registrar, StrataView Plus, Stratm, SwitchProbe, 
TeleRouter, and VCO are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and certain other countries. 

All other trademarks mentioned in this document or Web site are the property of their respective owners. The use of the word partner does not imply a 
partnership relationship between Cisco and any other company. (0108R)

Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide
Copyright © 2001, Cisco Systems, Inc.
All rights reserved.



 

iii
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

C O N T E N T S

Preface vii

Document Objective vii

Audience viii

Document Organization viii

Terminology viii

Document Conventions ix

Documentation Suite x
Hardware Documentation x
Software Installation and Configuration Documentation x
Gateway Documentation xi
Documentation Map xi

Obtaining Documentation xii
World Wide Web xiii
Documentation CD-ROM xiii
Ordering Documentation xiii
Documentation Feedback xiii

Obtaining Technical Assistance xiv
Cisco.com xiv
Technical Assistance Center xiv

Contacting TAC by Using the Cisco TAC Website xiv
Contacting TAC by Telephone xv

Document Change History xv

C H A P T E R   1-1 Voice Services Provisioning Tool Overview 1-1

Provisioning Introduction 1-1

VSPT Introduction 1-2

Installing the VSPT 1-2
Prerequisites 1-3
Preplanning 1-4
Upgrading VSPT Software 1-4

Saving Configuration Files 1-4
Uninstalling the VSPT Software 1-4

Installing the VSPT Software 1-5

VSPT Basics 1-6



 

Contents

iv
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

VSPT Field Definitions 1-6
VSPT Data Entry Requirements 1-8

Starting the VSPT 1-8

Using the VSPT 1-9
Menu Bar 1-9
Buttons 1-11

Defining Users and Permissions 1-11

Exiting the VSPT 1-12

C H A P T E R   2-1 Provisioning with VSPT Wizards 2-1

Starting a New Provisioning Session 2-1

Overview of the VSPT Wizards 2-3

Using the Tandem Transit Solution Wizard 2-4
Configuring the Cisco MGC 2-4
Configuring SS7 Signaling Services 2-6
Configuring Media Gateway Control Links 2-10
Provisioning Session Results 2-12
Viewing Generated MML 2-14

C H A P T E R   3-1 Manual Provisioning with the VSPT 3-1

Configuring the Cisco MGC 3-1
Adding an MGC Host 3-2
Adding Ethernet Cards and Interfaces 3-4

Configuring SS7 Signaling Services 3-7
Adding Adjacent Point Codes 3-7
Add Point Codes 3-8

Add Destination Point Codes 3-9
Add Origination Point Code 3-10

Add Linksets 3-11
Adding and Changing Linkset Properties 3-13
Add C7 IP Links 3-14

Add SS7 Subsystems (Mated Pairs) 3-17
Configure SS7 Paths 3-20
Configure SS7 Routes 3-22
Configure FAS Signaling 3-24

Add or Modify FASPath properties 3-26

Configuring Media Gateway Control Links 3-27
Adding External Nodes 3-28



 

Contents

v
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Configuring MGWs 3-29
Adding a Broadband or Narrowband Service Card 3-32
Adding an IPFAS Signaling Service 3-34

Adding IP Links for IPFAS 3-37
Changing IPFAS Signaling Service Properties 3-40

Adding an MGCP Signaling Service 3-41
Adding and Changing MGCP Signaling Service Properties 3-43
Add an IP Link for MGCP 3-44

Configuring Bearer Traffic 3-46
Importing Trunk Groups and Trunks 3-47
Add a Trunk Group 3-48
Adding Trunks 3-51
Deleting Trunks from a Trunk Group 3-53
Adding Route Groups and Routes 3-54
Hierarchical View of Provisioned Components 3-56

Performing an Integrity Check 3-57
Checking Integrity for MGC Signaling Configuration 3-57
Checking Traffic Against MGC Configuration 3-58

Viewing Generated MML 3-60

Viewing Generated Cisco MGW Commands 3-60

Deploying a New Configuration 3-61

Backup and Restore 3-64
Schedule An Activity 3-64

Check Status of Backup or Restore 3-67

C H A P T E R   4-1 Provisioning the Billing and Measurements Server 4-1

Starting a BAMS Provisioning Session 4-2

BAMS Provisioning 4-4
Provisioning General Information 4-4
Provisioning Zones 4-6
Provisioning Trunk Group Information 4-10
Provisioning Measurements 4-13



 

Contents

vi
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01



 

vii
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Preface

This preface describes the objectives, audience, organization, and conventions of this document and 
explains how to find additional information on related Cisco products and services. It contains the 
following sections:

• Document Objective, page vii

• Audience, page viii

• Document Organization, page viii

• Terminology, page viii

• Document Conventions, page ix

• Documentation Suite, page x

• Obtaining Documentation, page xii

• Obtaining Technical Assistance, page xiv

• Document Change History, page xv

Document Objective
This document provides the information you need to install, configure, and use the Voice Services 
Provisioning Tool (VSPT), Version 1.6 . You should read the system-level documentation supplied with 
your system before using this guide. A complete list of these documents is included in the Cisco Media 
Gateway Controller Release 7 Software Installation and Configuration Guide that ships with your 
system.

Note This document uses the term Media Gateway Controller software or MGC application to mean the 
Cisco MGC software that runs in the UNIX environment on a server. The term MGC refers to the 
combination of this software and the server. The Cisco MGC communicates with the SS7 network to 
process and route calls between a traditional time-division multiplexing (TDM) network and a packet 
data network. This routing takes place through a variety of media gateways, separate devices that 
perform the conversion between the TDM and data network formats.

Note The Cisco PGW 2200 PSTN Gateway (hereafter referred to as Cisco PGW 2200) was formerly called 
the Cisco VSC3000. Some parts of this document may use this older name.
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Audience
This document is designed for network operators and administrators who have experience with 
telecommunications networks, protocols, and equipment and who have familiarity with data 
communications networks, protocols, and equipment. Software and hardware installers and network 
designers will also find this document useful.

Document Organization
Table 1 describes the major sections of this document.

Terminology
The following terms are used in this document:

Cisco MGC host—A Sun host server running Cisco media gateway controller software. If your product 
is the Cisco PSTN Gateway (PGW), this is also called an SC host. If your product is the Cisco VSC3000, 
this is also called a virtual switch controller (VSC) host.

Cisco SC node—The combination of the Cisco SC2200 product and the control signaling network. The 
SC node consists of all solution components except the media gateway. 

Cisco VSC node—The logical grouping of the active and standby VSC hosts, the control signaling 
network, and the Cisco Signaling Link Terminals (SLTs). 

Cisco MGC node—Either the Cisco SC node or the Cisco VSC node.

Simplex MGC node—A node that uses a single Cisco MGC host. Typically, this type of node is used for 
solution evaluation tests or for small installations. In this configuration, any loss of service in the 
Cisco MGC host disrupts all call traffic. If your product is the Cisco SC2200, this is also called a simplex 
SC node. If your product is the Cisco VSC3000, this is also called a simplex VSC node.

Continuous-service MGC node—A node that uses two Cisco MGC hosts to prevent system downtime 
caused by failure of a single MGC host. Calls in progress are maintained when one MGC host fails. 
Continuous-service nodes use SLTs to preprocess SS7 signaling and distribute signaling to both MGC 

Table 1 Document Organization

Chapter Title Description

Chapter 1 Voice Services Provisioning 
Tool Overview

Introduces Release 1.6 of the VSPT and 
provides directions for obtaining and installing 
the software. In addition, it provides basic 
information for using the tool.

Chapter 2 Provisioning with VSPT 
Wizards

Introduces VSPT wizards and provides an 
example of configuring a Cisco Media Gateway 
Controller (MGC) through the use of a wizard.

Chapter 3 Manual Provisioning with the 
VSPT

Shows you how to use Release 1.6 of the VSPT 
to manually provision a Cisco MGC.

Chapter 4 Provisioning the Billing and 
Measurements Server

Provides directions for using Release 1.6 of the 
VSPT for provisioning a Billing and 
Measurements Server (BAMS).
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hosts. If a failover occurs, all stable calls are maintained. If your product is the Cisco SC2200, this is 
also called a continuous-service SC node. If your product is the Cisco VSC3000, this is also called a 
continuous-service VSC node.

Document Conventions
Typographic conventions used in this guide are shown inTable 2 .

Table 2 Conventions Used in this Guide

Convention Meaning Description / Comments

Boldface Commands and keywords 
you enter as shown.

offset-list 

Italics Variables for which you 
supply values.

command type interface

You replace the variable with specific 
information.

In contexts that do not allow italics, 
such as online help, arguments are 
enclosed in angle brackets (< >).

Square brackets ([ ]) Optional elements. command [abc]

abc is optional (not required), but you 
can choose it.

Vertical bars ( | ) Separated alternative 
elements.

command [ abc | def ]

You can choose either abc or def, or 
neither, but not both.

Braces ({ }) Required choices. command { abc | def }

You must choose either abc or def, but 
not both.

Braces and vertical bars 
within square brackets 
([ { | } ])

A required choice within an 
optional element.

command [ abc { def | ghi } ]

You have three options:

nothing

abc def

abc ghi

Caret character (^) Control key. The key combinations ^D and Ctrl-D 
are equivalent: Both mean “hold down 
the Control key while you press the D 
key.” Keys are indicated in capital 
letters and are not case sensitive.

A non-quoted set of 
characters

A string. For example, when setting an SNMP 
community string to public, do not use 
quotation marks around the string; 
otherwise, the string will include the 
quotation marks.
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Caution Means reader be careful. In this situation, you might do something that could result in equipment 
damage or loss of data.

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in 
the publication.

Documentation Suite
Consult the following related documentation for information about the Cisco MGC software and the 
solutions it supports, including the Cisco SS7 Interconnect for Access Servers Solution, the Cisco SS7 
Interconnect for Voice Gateways Solution, and the Cisco Packet Tandem Solution.

Hardware Documentation
• Cisco Media Gateway Controller Hardware Installation Guide

• Regulatory Compliance and Safety Information for Cisco Media Gateway Controller Hardware

Software Installation and Configuration Documentation
• Cisco Media Gateway Controller Software Release 7 Installation and Configuration Guide

• Cisco Media Gateway Controller Software Release 7 Provisioning Guide

• Cisco Media Gateway Controller Software Release 7 Dial Plan Guide

• Cisco Media Gateway Controller Software Release 7 Operations, Maintenance, and 
Troubleshooting Guide

• Release Notes for Cisco Media Gateway Controller Software Release 7

• Cisco Media Gateway Controller Online Documentation Notice

System prompts Denotes interactive 
sessions, indicates that the 
user enters commands at the 
prompt.

The system prompt indicates the 
current command mode. For example, 
the prompt Router (config) # 
indicates global configuration mode.

Screen font Terminal sessions and 
information the system 
displays.

Angle brackets (< >) Non-printing characters 
such as passwords.

Exclamation point (!) at the 
beginning of a line

A comment line. Comments are sometimes displayed by 
the Cisco IOS software.

Table 2 Conventions Used in this Guide (continued)

Convention Meaning Description / Comments
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• Cisco Media Gateway Controller SLT Documentation Notice

Gateway Documentation
Cisco DAS and H.323 VoIP Gateway Installation and Configuration Guide

Documentation Map
Figure 1 shows the sequence in which the various manuals documenting Cisco telephony solutions 
should be read.
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Figure 1 Documentation Map

Obtaining Documentation
The following sections provide sources for obtaining documentation from Cisco Systems.

57
99

0

Regulatory Compliance and Safety
Information for Cisco Media Gateway

Cisco MGC Software Release 7
Provisioning Guide

Cisco MGC Software Release 7
Installation and Configuration Guide

Cisco MGC Hardware
Installation Guide

Release Notes for
Cisco MGC Software Release 7

Solution Gateway Hardware
Installation Guide

Cisco MGC Software Release 7
Dial Plan Guide

Cisco MGC Software Release 7 Operations,
Maintenance, and Troubleshooting Guide

Is
gateway
set up?

Yes

No

Regulatory Compliance and Safety
Information for Cisco MGC

Solution Overview

Cisco Voice Services Provisioning
Tool Version 1.6

Is
MGC host

set up?

Yes

No

* This guide provides useful information
that is not required during installation.

End

Solution Gateway Software
Installation and Configuration Guide

Solution Gateway
Provisioning Guide

Cisco MGC Software Release 7
Billing Interface Guide *

Cisco MGC Software Release 7 MML
Command Reference Guide *

Cisco MGC Software Release 7 
Messages Reference Guide *

Cisco MGC Software Release 7
Management Information Base Guide *
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World Wide Web
You can access the most current Cisco documentation on the World Wide Web at the following sites:

• http://www.cisco.com

• http://www-china.cisco.com

• http://www-europe.cisco.com

Documentation CD-ROM
Cisco documentation and additional literature are available in a CD-ROM package, which ships 
with your product. The Documentation CD-ROM is updated monthly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or through an 
annual subscription.

Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco Product documentation from the Networking 
Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM through the online Subscription 
Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, in North America, by 
calling 800 553-NETS(6387).

Documentation Feedback
If you are reading Cisco product documentation on the World Wide Web, you can submit technical 
comments electronically. Click Feedback in the toolbar and select Documentation. After you complete 
the form, click Submit to send it to Cisco.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover of your document, or 
write to the following address:

Attn Document Resource Connection
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
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Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partners can 
obtain documentation, troubleshooting tips, and sample configurations from online tools. For Cisco.com 
registered users, additional troubleshooting tools are available from the TAC website. 

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that provides immediate, open 
access to Cisco information and resources at any time, from anywhere in the world. This highly 
integrated Internet application is a powerful, easy-to-use tool for doing business with Cisco.

Cisco.com provides a broad range of features and services to help customers and partners streamline 
business processes and improve productivity. Through Cisco.com, you can find information about 
Cisco and our networking solutions, services, and programs. In addition, you can resolve technical 
issues with online technical support, download and test software packages, and order Cisco learning 
materials and merchandise. Valuable online skill assessment, training, and certification programs are 
also available.

Customers and partners can self-register on Cisco.com to obtain additional personalized information and 
services. Registered users can order products, check on the status of an order, access technical support, 
and view benefits specific to their relationships with Cisco.

To access Cisco.com, go to the following website:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC website is available to all customers who need technical assistance with a Cisco product 
or technology that is under warranty or covered by a maintenance contract.

Contacting TAC by Using the Cisco TAC Website

If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC by going to the TAC 
website:

http://www.cisco.com/tac

P3 and P4 level problems are defined as follows:

• P3—Your network performance is degraded. Network functionality is noticeably impaired, but most 
business operations continue.

• P4—You need information or assistance on Cisco product capabilities, product installation, or basic 
product configuration.

In each of the above cases, use the Cisco TAC website to quickly find answers to your questions. 

To register for Cisco.com, go to the following website:

http://www.cisco.com/register/

If you cannot resolve your technical issue by using the TAC online resources, Cisco.com registered users 
can open a case online by using the TAC Case Open tool at the following website:

http://www.cisco.com/tac/caseopen
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Contacting TAC by Telephone 

If you have a priority level 1 (P1) or priority level 2 (P2) problem, contact TAC by telephone and 
immediately open a case. To obtain a directory of toll-free numbers for your country, go to the following 
website:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

P1 and P2 level problems are defined as follows:

• P1—Your production network is down, causing a critical impact to business operations if service is 
not restored quickly. No workaround is available.

• P2—Your production network is severely degraded, affecting significant aspects of your business 
operations. No workaround is available. 

Document Change History
Table 0-3 Document Change History

Subject Document No., Change Date Change Summary

Online publication OL-1349-01, October 18, 2001 Initial online publication.
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1
Voice Services Provisioning Tool Overview

Cisco Open Packet Telephony (OPT) provides the framework for delivering voice services over 
packet-based data, voice, and video networks. OPT encompasses a broad range of hardware platforms 
and Cisco software, delivering a continuum of voice solutions from core infrastructure to enhanced 
services over circuit and packet networks. The Cisco Media Gateway Controller (MGC) is at the center 
of all Cisco OPT solutions.

Note A solution is a combination of Cisco hardware and software configured to perform a specific network 
task.

Provisioning is the process of preparing a Cisco Media Gateway Controller (MGC) to communicate with 
an SS7 network, with Cisco media gateways, and with the other components of an OPT solution. The 
Cisco Voice Services Provisioning Tool (VSPT) provides an easy-to-use graphical tool to provision 
Cisco Media Gateway Controllers. 

This chapter introduces the Voice Services Provisioning Tool (VSPT), Release 1.6, and provides 
directions for obtaining and installing the software. In addition, it provides basic information for using 
the tool.

This chapter contains the following sections:

• Provisioning Introduction, page 1-1

• VSPT Introduction, page 1-2

• Installing the VSPT, page 1-2

• VSPT Basics, page 1-6

• Starting the VSPT, page 1-8

• Using the VSPT, page 1-9

• Defining Users and Permissions, page 1-11

• Exiting the VSPT, page 1-12

Provisioning Introduction
All solutions involving the Cisco MGC are configuredwith one or more Cisco MGC hosts, one or more 
Signaling System 7 (SS7) network signaling options, and one or more media gateways that control 
bearer-traffic routing.
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VSPT Introduction

Prior to starting any provisioning session, you should have a clear understanding of the network 
topology for your solution. Create a network drawing, and refer to it while configuring your network.

In addition, you should perform the following tasks before using this guide:

• Thoroughly plan your network configuration. Refer to the documentation for your solution for 
detailed network configuration information.

• Set up your system hardware, and install all required software. For more information, refer to 
“Prerequisites” section on page 1-3, and the following documents

– Cisco Media Gateway Controller Hardware Installation Guide

– Cisco Media Gateway Controller Software Release 9 Installation and Configuration Guide

VSPT Introduction
The VSPT can be deployed as an integrated component of the Cisco MGC Node Manager or as a 
standalone application. It typically runs on a separate UNIX server and supports multiple users and 
provisioning sessions. It allows you to import an existing configuration, modify the configuration, and 
export it to the same or different devices. Alternately, it offers you high-level configuration steps that 
you can use to create the initial network provisioning information for a newly installed node, creating 
iterative entries from a single operation. It can also facilitate provisioning of individual call parameters, 
simplifying the provisioning of a large live network.

During a provisioning session, the VSPT automatically generates the Man Machine Language (MML) 
or command line interface (CLI) scripts used to configure network elements, assembles these commands 
into a batch file, and deploys the file to the appropriate network device. 

Note This document does not include instructions for dial plan provisioning. For dial plan information, 
refer to the Cisco Media Gateway Controller Software Release 7 Dial Plan Guide.

Installing the VSPT
If you are a registered Cisco Connection Online (CCO) user, you can download the VSPT software from 
the Cisco website. Before installing the VSPT, you must verify the following:

• You have the latest release of the VSPT software. Visit the following Cisco website to check the 
VSPT release number (a valid login to the VSPT Cisco website is required):

http://www.cisco.com > Software Center > Voice Software > Cisco Voice Services Provisioning 
Tool

• The workstation hardware and software requirements have been met.

• The network connectivity has been established between your workstation and the network elements. 

• The network elements have the correct release of software installed. 

Note Make sure you have root access on your Sun workstation (sudo access is not adequate).
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Installing the VSPT

Tip Before you begin provisioning, you should have a list of components you want to provision, 
including the component names, IP addresses, properties, and other parameters. You can create them 
using the worksheets provided in the Cisco Media Gateway Controller Software Release 7 
Provisioning Guide. In addition, descriptions of the properties and values contained in the VSPT are 
included in Appendix A of the Cisco Media Gateway Controller Software Release 7 Provisioning 
Guide and in the following chapter. Review this information before you begin provisioning and keep 
it available for reference during provisioning.

Prerequisites
To install the VSPT software, you must have the following:

• Sun SPARC station running Solaris version 2.6 or earlier. 

• Sun Ultra-5 Workstation (333 MHz or faster).

• Sun Solaris 2.6 (5/98 release is recommended).

• Open windows with the Common Desktop Environment (CDE).

• Latest Solaris 2.6 recommend patch set. (Log in to http://sunsolve.sun.com then click on Patches).

• Cisco Media Gateway Controller Software Release 7.

• 8-bit video graphics card.

• Disk space:

– Approximately 20 MB of disk space for installation

– Directory /var/opt/data/

Approximately 1 MB for each configuration

Approximately 1 MB for each configuration snapshot

– Directory /var/opt/log/

Approximately 0.5 MB for each deployment

• RAM:

– Minimum: 128 MB

– Recommended: 256 MB or greater

• Swap space:

– Minimum: 128 MB

– Recommended: 256 MB or greater

• Cisco Media Gateway Controller Software Release 7 

Note Running the VSPT on the same host as the Cisco MGC can adversely impact performance. We 
recommend using a separate server.
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Preplanning
VSPT supports multiple solutions and enables you to provision components for these solutions. Some 
components may not apply to your solution. Make sure you understand your solution component 
requirements. For information, refer to the provisioning guide for your solution.

Upgrading VSPT Software
If you have an older release  of the VSPT already installed (such as VSPT, Release 1.5) and you are 
upgrading to VSPT Release  1.6, the existing VSPT data is automatically migrated to VSPT Release  2.0; 
you do not need to uninstall the older release . However, if an incremental release is detected during the 
installation, you are prompted to uninstall the older release (for example, Release  1.5.1 cannot coexist 
with Release  1.5.2 and must first be uninstalled).

Note Because the uninstall directory and files are removed during uninstall, do not run the uninstall script 
from within the /opt/CSCOspgw directory.

Saving Configuration Files

Before uninstalling the VSPT software, you can save current configuration data and administrative 
information so users and logins do not have to be recreated after the upgrade. Use the following 
procedure to save data and user information:

Step 1 Log in to the server as root.

Step 2 Create a temporary directory to hold the pertinent files.

Step 3 Use the following command to copy the password file, /var/opt/CSCOvspXX/etc/dartpwd.txt, to the 
temporary directory.

# cp -p /var/opt/CSCOvspXX/etc/dartpwd.txt /<temporary directory>/dartpwd.txt

Step 4 Change to the /var/opt/CSCOvspXX/data directory.

Step 5 Use the tar commend to archive all files in the directory.

Note The tar command preserves file permissions.

Step 6 Copy the archive file to the temporary directory.

After you upgrade the VSPT software, replace the /var/opt/VSVOvsp<New>/etc/dartpwd.txt file and the 
/var/opt/CSCOvsp<New>/data directory with the archive files you saved in the temporary directory.

Uninstalling the VSPT Software

Use the following procedure to uninstall the software:

Step 1 Enter the following commands:
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>su -root

>cd /

>/opt/CSCO15/uninstall/uninstall

The uninstallation process removes all files and directories created by the installation process. If a 
directory contains a file that was not created during the installation process, it is not removed and is 
logged in the uninstall.log file. This might occur in the data and log directories.

Step 2 Proceed with the VSPT software installation (see “Installing the VSPT Software” section on page 1-5).

Installing the VSPT Software
To install the software from the Cisco website, follow the procedure listed below:

Step 1 Verify that the requirements listed in “Prerequisites” section on page 1-3 have been met.

Step 2 Become the root user by entering the following command: 

>su - root

Step 3 Create the temporary directory /var/tmp/CSCOvsp16-install by entering the following command:

#mkdir -p /var/tmp/CSCOvsp16-install

Step 4 Open a web browser, and go to the following site: 

http://www.cisco.com> Software Center > Network Management > Cisco Voice Services 
Provisioning Tool

Step 5 Select the desired release number.

Step 6 Download the software to the temporary directory /var/tmp/CSCOvsp16-install.

Step 7 Extract the software image using the following tar command:

#tar xvf <filename>.tar

Step 8 Run the setup program by entering the following command:

#./setup

Note You can avoid the GUI and install the Cisco VSPT in TTY mode by entering the following command: 
#./setup -nodisplay, and following the onscreen prompts. An X-server must be running, and the 
DISPLAY environment variable must be properly configured. Use one of the following commands, 
depending on which shell you are using, to set the x-display variable.

In “csh” or “tcsh”: setenv DISPLAY <hostname>:0
In “sh” or “ksh”: DISPLAY=<hostname>:0;export $DISPLAY

Step 9 Follow the onscreen prompts.

Step 10 Remove the /var/tmp/CSCOvsp16-install directory when the installation is complete by entering the 
following command:

#rm -rf /var/tmp/CSCOvsp16-install

Step 11 Change to the installation directory, /opt/CSCOvsp16.
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Step 12 Run the VSPT Release 1.6 program by entering the following command:

#./dart

Installation of the VSPT software is now complete. Table 1-1 lists the default VSPT directories and files. 
If you have questions or need assistance, see the “Obtaining Technical Assistance” section on page -xiv

VSPT Basics
This section describes VSPT fields and data entry requirements..

VSPT Field Definitions
Table 1-2 lists VSPT field names and their corresponding system components. For more information 
about system components, refer to the Cisco Media Gateway Controller Software Release 7 Provisioning 
Guide.

Table 1-1 Installation Directories and Files

Directory

/opt/CSCOvsp216 (home directory)

dart VSPT application script

classes/ Class and properties files

images/

jre/ Java Runtime Environment

uninstall/ Uninstall script directory

version VSPT version

/var/opt/CSCOvsp16 (home directory)

data/ Configuration files

logs/ Log files

/etc

Table 1-2 Field Definitions

Field Name Component Description

MGC Host Origination point code (OPC), the address of the Cisco MGC 
you are provisioning.

Interfaces (cards) Ethernet hardware cards and virtual interfaces (connections) for 
the Ethernet cards in the Cisco MGC host.

Adjacent Point Codes The address of an STP1 that sends signaling messages to and 
receives signaling messages from the Cisco MGC.
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LinkSets Links from the MGC to an endpoint, such as an adjacent STP.

C7 IP Link A link to the SS7 network (for example, an SSP2 or STP) from 
the Cisco MGC through a Cisco SLT.

Mated Pairs (SS7 
Subsystem)

A logical connection between a pair of mated STPs that allows 
the Cisco MGC to route through either STP to an endpoint.

Point Code Destination point code (DPC), the address of an endpoint, such 
as a PSTN3 switch that carries the bearer traffic.

SS7 Path (SS7 
Signaling Service)

An SS7 connection between the Cisco MGC and a specified 
point code.

SS7 Route A route for each signaling path from the Cisco MGC to the 
PSTN switch through the linksets you have created to the STPs.

External Node Any object in the network that is connected to the Cisco MGC, 
for example, a media gateway (Cisco MGW) and associated 
BSCs4.

Note Cisco SLTs perform MTP layer 2 processing only. 
Therefore, they are not considered to be external nodes.

MGCP5 Signaling 
Service

A signaling service between the Cisco MGC and a media 
gateway. 

IPFAS Signaling 
Service

A signaling service (over IP) between the Cisco MGC and a 
media gateway.

IP Links for MGCP 
and IPFAS

Links for the MGCP and IPFAS signaling services.

1. STP = signal transfer point.

2. SSP = service switching point.

3. PSTN = Public Switched Telephone Network.

4. BSC = Broadband service card.

5. MGCP = Media Gateway Control Protocol.

Figure 1-1 shows the relationship among the components listed in Table 1-2.

Table 1-2 Field Definitions (continued)

Field Name Component Description
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Figure 1-1 Component Relationships

VSPT Data Entry Requirements
When entering data into the VSPT windows, follow standard MML conventions for names and 
descriptions. MML names must have the following characteristics:

• A maximum of 20 alphanumeric characters, including dashes

• No space, underscore, or special characters

• Must start with an alphabetic character

• Must be lowercase

For example: name="dpc1"

MML descriptions can be as many as 128 characters and can include spaces and symbols. You should 
use a description that helps to identify the component or link that you are provisioning. For example, for 
an SS7 route that indicates the signaling path from the Cisco MGC to a switch through a linkset, you 
could create a description “SS7 Route to PSTN Switch A through Linkset 1.” For more information 
about MML, refer to the Cisco Media Gateway Controller Software Release 7 MML Command 
Reference Guide.

The VSPT GUI enables you to step through the provisioning process in a logical sequence. The sequence 
of steps is described in the Cisco Media Gateway Controller Software Release 7 Provisioning Guide.

Starting the VSPT
Perform the following steps to start the VSPT:

Step 1 Log in to the VSPT server or access it from a machine with X-windows capability.

Step 2 In a terminal window, enter:

>cd /opt/CSCOvsp16

IP
link
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Node

Point
Code

Adjacent
Point
Code

Ethernet
interface

Ethernet
adapter

MGCP
signaling

Linkset

IPFAS
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SS7
signaling
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38
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The default directory is /opt/CSCOvsp16. Navigate to the appropriate directory if you installed the 
VSPT in a different location.

Step 3 Enter the following command to start the VSPT application:

>./dart

The system opens the X-windows , and the login screen appears.

Step 4 Enter your user name and password, and click OK.

The default beta user name is admin, and the default password is also admin. The Welcome screen is 
displayed briefly during the login process, and then the main window appears (see Figure 1-2).

Figure 1-2 Main Window

Using the VSPT
This section describes the VSPT menus and buttons and provides directions for using the tool functions.

Menu Bar
The VSPT provides a menu bar that contains the following selections:

• File

• View



 

1-10
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Chapter 1      Voice Services Provisioning Tool Overview
Using the VSPT

• Tools

• Help

The File menu contains the choices listed in Table 1-3.

The View menu contains the choices listed in Table 1-4.

The Tools menu contains the choices listed in Table 1-5.

Table 1-3 File Menu Choices

Choice Description

New Begin a new configuration session.

Open Open an existing configuration.

Import Import an existing configuration from a MGC, as well as import trunk 
group, trunk, routing, and dial plan files into the VSPT.

Export Export files from the VSPT.

Save Save the current configuration:

• As Working

• As Snapshot

• As New Config

Note For more information on the different save options, see the 
“Starting a New Provisioning Session” section on page 2-1.

Exit Stop any open provisioning sessions and close the VSPT.

Table 1-4 View Menu Choices

Choice Description

MML Show generated MML for the current configuration.

MGW Commands Show generated Cisco MGX 8850 commands for the current 
configuration.

Trunk Group File Show generated trunk group file for the current configuration.

Trunk File Show generated trunk file for the current configuration.

Table 1-5 Tools Menu Choices

Choice Description

Integrity Check Check your configuration for inconsistencies and missing information.

Deploy Move the configuration to one or more target hosts and Cisco MGWs.

Telnet Open a Telnet session.

MGC Viewer View MGC configurations.

MGX-8850 Wizard View and configure MGX 8850 hosts.

BAMS Config View and configure a Billing and Measurement Server (BAMS)
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Buttons
The VSPT provides buttons and explorer trees to move through the system. Click these buttons to add 
or change network components. The VSPT contains the following buttons:

• MGC Config—Add components and provision component properties.

• Traffic—Create customer-specific files, including trunk groups, trunks, and routing.

• Number Analysis—Provision a dial plan.

The left side of the screen displays selectable components. The right side of the screen displays data 
entry fields. Click a component to select it. To see all subcomponents, click the icon next to the 
component name to expand the component list.

The Help menu selection displays the information about the current build release number.

Defining Users and Permissions
After you install the VSPT, you should define users and their respective permissions.

Use the following procedure to define users:

Step 1 Click Tools > User Admin.

The screen in Figure 1-3 appears.

State Operation View and configure the state of MGC components.

Screening Editor View and configure screening number provisioning.

Backup and Restore Schedule and perform a backup or restore of an existing configuration.

Make Seed File Use an existing configuration to create a text file that can be used by the 
Cisco Media Node Manager (CMNM).

Table 1-5 Tools Menu Choices

Choice Description
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Figure 1-3 VSPT User Administration

Step 2 Add, modify, or delete users as follows:

• To add a user, enter a user name and password, click Permission, select the permission level, and 
click Add.

• To modify a user, select the user name, change the password or permission level, and click Modify.

• To delete a user, select the user name, and click Delete.

Exiting the VSPT
You can exit the VSPT at any time by performing one of these actions:

• Click File > Exit. Click OK at the prompt.

• Click the close box in the upper right of the VSPT screen. Click OK at the prompt.
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Wizards are utilities included in the Cisco VSPT to help you rapidly create a new deployment by 
providing a graphical user interface (GUI) for provisioning specific Cisco MGC configurations. A 
wizard leads you through the steps of provisioning the Cisco MGC and external components. 

This chapter describes wizards and provides an example showing how you can use a wizard to configure 
a Cisco MGC. It includes the following sections:

• Starting a New Provisioning Session, page 2-1

• Overview of the VSPT Wizards, page 2-3

• Using the Tandem Transit Solution Wizard, page 2-4

Starting a New Provisioning Session
Use the following procedure to start a new VSPT provisioning session:

Step 1 Start and log in to the VSPT.

Step 2 Select File > New.

Step 3 Enter a name for the new configuration you will create, and click OK. The screen shown in Figure 2-1 
appears.
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Figure 2-1 Select Method for Creating Configuration

Step 4 If you want to import an existing configuration, click the Import from MGC radio button, and click 
Select; otherwise, click Perform Manual Configuration and proceed to Chapter 3, or choose the wizard 
you want to use.

If you import an existing configuration, a screen similar to the one shown in Figure 2-2 appears.

Figure 2-2 Select Configuration

Step 5 Select the configuration to import, and click OK. The screen shown in Figure 2-3 is displayed, and 
checkmarks appear in the boxes as the configuration is imported. 
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Figure 2-3 Importing Configuration

Step 6 The existing configuration is imported from your Cisco MGC.

Overview of the VSPT Wizards
The VSPT includes two provisioning wizards:

• SS7-PRI Gateway—Offloads modem dial traffic from CLEC switches and either forwards the calls, 
using SS7, to the destination CLEC switches or translates the calls to ISDN PRI to terminate them 
on the NAS gateways.

• Tandem Transit—Offloads modem dial traffic from CLEC switches and forwards the calls to the 
Internet Protocol (IP) network.

Each wizard automatically guides you through many of the steps involved in provisioning your 
Cisco MGC. A VSPT wizard:

• Lets you create configuration files across multiple devices, for example, VSCs and 
Cisco MGX 8850s.

• Helps you avoid common errors when you are provisioning devices independently, for example, it 
ensures that you correctly match D channels for PRI.

• Lets you avoid having to repeatedly enter the same data.

• Creates the MML files and the Cisco MGX 8850 command files used to provision the VSC.

In the example in this chapter, a wizard is used to provision a Cisco MGC for tandem transit with STP 
links, but the process is similar for all VSPT wizards. Specific components and steps vary, depending 
on the wizard you are using; for a complete description of provisioning components, refer to the 
documentation for your solution.

When you finish the provisioning session, the VSPT wizard saves your configuration as the “active” 
configuration, and it cannot be modified. To make changes, you must save the configuration with 
another name and deploy the new provisioning session to make it active.

The number of configurations you can store might be limited by available disk space. Consider deleting 
old or unwanted configurations, or save them to another machine, if you do not have sufficient disk 
space.
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Note The provisioning procedures described in this chapter follow the sequence for provisioning a 
“typical” Cisco MGC described in the Cisco Media Gateway Controller Release 7 Provisioning 
Guide.

Using the Tandem Transit Solution Wizard
The VSPT utility, Solution Wizard: Tandem Transit, guides you step-by-step through the following 
procedures:

• Configuring the Cisco MGC, page 2-4

• Configuring SS7 Signaling Services, page 2-6

• Configuring Media Gateway Control Links, page 2-10

When you finish using the VSPT wizard, you must still configure the trunk groups, trunks, and routes. 
For more information, see the “Configuring Bearer Traffic” section of Chapter 3.

Tip Before you begin provisioning, compile information about the solution components, including their 
names, IP addresses, and properties. Worksheets designed for collecting this information are 
provided in the Cisco Media Gateway Controller Software Release 7 Provisioning Guide. Complete 
them before you begin provisioning, and refer to them during provisioning.

Configuring the Cisco MGC
Use the following procedure to provision a Cisco MGC using the Tandem Transit with STP wizard:

Step 1 Start a new provisioning session.

Step 2 Click File > New.

Step 3 Click the Solution Wizard: Tandem Transit button, and click OK. A screen similar to the one in 
Figure 2-4 appears.
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Figure 2-4 Specifying Cisco MGC (VSC3000) Properties

Step 4 Enter the MGC IP address, for example, 161.44.157.1, in the MGC Hostname field.

Step 5 Enter a login ID and a password. 

Step 6 Click Next. A screen similar to the one in Figure 2-5 appears.

Figure 2-5 Specifying MGC IP Addresses

Step 7 Enter the network addresses of the MGC (IP_Addr1 and IP_Addr2) in dotted notation, for example, 
172.18.145.38.
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Step 8 Click Next. A screen similar to the one in Figure 2-6 appears, and SS7 signaling service provisioning 
begins.

Figure 2-6 Specifying a Point Code

Configuring SS7 Signaling Services
Use the following procedure to configure SS7 signaling services:

Step 1 Enter a name for the point code, for example, OPC.

Step 2 Enter a description of the point code, for example, Originating Point Code.

Step 3 Enter the network address (NetAddr) of the MGC in dotted notation, for example, 172.44.102.39.

Step 4 From the NetIndicator drop-down menu, choose the network indicator menu:

• International—Used if the node is an international gateway.

• Spare—Used in countries where multiple carriers share point codes; networks are differentiated by 
this indicator.

• National—Used if the node routes calls through the national network (default).

• Reserved—For national use. Do not use.

Step 5 Click Next. A screen similar to the one in Figure 2-7 appears.
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Figure 2-7 Specifying the Number of Adjacent Point Codes 

Step 6 Enter the number of adjacent point codes (APCs) to create. This number corresponds to the number of 
Cisco MGX 8850 switches to be provisioned. Click Next. A screen similar to the one in Figure 2-8 
appears.

Figure 2-8 Specifying Properties for Each APC

Step 7 Enter a name for the APC.

Step 8 Enter a description of the APC.



 

2-8
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Chapter 2      Provisioning with VSPT Wizards
Using the Tandem Transit Solution Wizard

Step 9 Enter the network address (NetAddr) of the APC in dotted notation; for example, 244.0.123.

Step 10 From the NetIndicator drop-down menu, choose the network indicator:

• International—Used if the node is an international gateway.

• Spare—Used in countries where multiple carriers share point codes; networks are differentiated by 
this indicator.

• National—Used if the node routes calls through the national network (default).

• Reserved. For national use. Do not use.

Step 11 Click Next. A screen similar to the one in Figure 2-9 appears.

Step 12 Repeat Step 7 through Step 11 for each APC. After you have configured properties for each APC you 
specified in Step 6, a screen similar to the one shown in Figure 2-9 appears. 

Figure 2-9 Specifying Properties for Mating APCs

Step 13 Enter the name (the default APC mate).

Step 14 Choose the protocol family.

Step 15 Choose the transport protocol.

Step 16 Click Next. A screen similar to the one in Figure 2-10 appears.
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Figure 2-10 Specifying a Protocol for Linksets

Step 17 Enter the linkset name prefix (the default is lnkset).

Step 18 From the Linkset protocol drop-down menu, choose the linkset protocol. 

Step 19 Click Next. A screen similar to the one in Figure 2-11 appears.

Figure 2-11 Specifying Values for C7 IP lnks

Step 20 Enter the name prefix.
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Step 21 Enter the network addresses (IP addr for SLT 1 and IP addr for SLT 2) in dotted notation; for example, 
172.18.145.38.

Step 22 Enter the local port. 

Step 23 Click Next. A screen similar to the one in Figure 2-12 appears, and media gateway control links 
provisioning begins.

Figure 2-12 Specifying the Number of Destination Point Codes

Configuring Media Gateway Control Links
Use the following procedure to configure media gateway control links for this solution:

Step 1 Enter the number of the destination point code (DPC) to create. 

Step 2 Click Next. A screen similar to the one in Figure 2-13 appears.



 

2-11
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Chapter 2      Provisioning with VSPT Wizards
Using the Tandem Transit Solution Wizard

Figure 2-13 Specifying Properties for Each DPC

Step 3 Enter the DPC name.

Step 4 Enter the network address of the destination network element in dotted notation; for example, 
172.18.145.38.

Step 5 Enter the SS7 path name.

Step 6 From the MDO drop-down menu, choose the protocol for this signaling service, for example, 
ANSISS7_STANDARD.

Step 7 Enter the customer group ID.

Step 8 Enter the customer group table.

Step 9 Enter the SS7 route name prefix. 

Step 10 Click Next. A screen similar to the one in Figure 2-14 appears. 
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Figure 2-14 Importing VISMs from the MGX 8850 Chassis

Step 11 Enter the MGX 8850 host name in which the VISM cards are installed. 

Step 12 Enter the MGX 8850 login ID.

Step 13 Enter the MGX 8850 password.

Step 14 Click Import VISMs. A list of the imported MGX 8850 switches appears in the lower portion of the 
screen.

Step 15 Click Finish. Media gateway control links are provisioned, and you can now provision trunk groups, 
trunks, and routes for this solution. Refer to “Configuring Bearer Traffic” section on page 3-46.

Provisioning Session Results
The results of the provisioning session you just completed are visible in the hierarchical tree on the left 
pane of the screen. You can expand the branches to view individual components, (see Figure 2-15).
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Figure 2-15 Expanded Hierarchical Tree Showing Results of Provisioning Session

You can expand the branches to view individual components. To view the provisioning information for 
a particular system component, click on the component name. Information about the selected component 
is shown on the right-hand side of the screen (see Figure 2-16).

Figure 2-16 View a Selected Component Configuration
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Viewing Generated MML
To view the MML commands generated by the VSPT wizard, select View > MML. A screen displaying 
generated MML, similar to the one shown in Figure 2-17, appears.

Figure 2-17 Generated MML

If you have used a different solution wizard, you can view the commands generated by the wizard by 
clicking View > <External Component>Commands.

You cannot use the VSPT wizard to provision trunk groups, trunks, and routes. For more information 
about provisioning these components using the VSPT, see “Configuring Bearer Traffic” section on 
page 3-46.
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Provisioning a Cisco MGC is a complex process that can be logically divided into the following steps:

• Configuring the Cisco MGC

• Configuring communications between the Cisco MGC and external SS7 signaling points (SPs), such 
as STPs

• Configuring call control links between the Cisco MGC and the media gateways

• Configuring bearer traffic

The provisioning procedures described in this chapter follow the sequence for provisioning a “typical” 
Cisco MGC configuration described in the Cisco Media Gateway Controller Software Release 7 
Provisioning Guide. Please refer to that document for more detailed provisioning information. 

Note The configuration of your MGC contain different components than those described in this chapter, 
requiring additional provisioning procedures. Please refer to the provisioning guide for your 
configuration for more detailed information.

This chapter shows how to use version 1.6 of the VSPT to provision a typical Cisco Media Gateway 
Controller (MGC) and contains the following sections:

• Configuring the Cisco MGC, page 3-1

• Configuring SS7 Signaling Services, page 3-7

• Configuring Media Gateway Control Links, page 3-27

• Configuring Bearer Traffic, page 3-46

Configuring the Cisco MGC
To provision a Cisco MGC, configure the following basic network elements:

• Active MGC host

• Standby MGC host, if applicable

• Ethernet cards and interfaces installed in the Cisco MGC host 
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Adding an MGC Host
The Cisco MGC host is a Sun workstation running the Cisco MGC software. Table 3-1 lists the MGC 
host properties. Use the information in the table to add an MGC host (and a standby host, if you are 
configuring a redundant MGC).

Perform the following steps to add an MGC host and a standby host, if applicable. Where necessary, 
refer to Table 3-1 for property values.

Step 1 Start a new provisioning session, and click File > New. The screen shown in Figure 3-1 appears.

Figure 3-1 Name Configuration

Step 2 Enter a name for the new configuration, and click OK. 

Step 3 Click the Perform manual configuration radio button, and click OK.

Step 4 Click the MGC Config radio button, and click Unknown MGC. The screen shown in Figure 3-2 
appears.

Table 3-1 MGC Property Properties

Property Name Description Default Valid Values

MGC Hostname IP address that identifies the target MGC host None User defined

Login/Password Specifies the valid MGC login and password None User defined

BAMS Config Identifies the name of the Billing and Measurement Server (BAMS) 
configuration, in dotted decimal notation

<UNSET> x.x.x.x

IP Addr:1 IP address, in dotted decimal notation, of the MGC primary 
interface used for signaling and control

None x.x.x.x

IP Addr:2 IP address, in dotted decimal notation, of a secondary interface used 
for signaling and control backup

None x.x.x.x

Failover Indicates if this is a failover configuration None No, Yes

Failover IP 
Addr:1

IP address , in dotted decimal notation, of the primary interface for 
signaling on the standby MGC (if included)

None x.x.x.x

Failover IP 
Addr:2

IP address, in dotted decimal notation, of the secondary interface for 
signaling on the standby MGC (if included)

None x.x.x.x
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Figure 3-2 Adding a Cisco MGC Host

Step 5 Enter the IP address of the MGC host, for example, 172.18.145.38.

Step 6 Enter a valid MGC login ID and password.

Step 7 Select the radio button corresponding to the version of the Billing and Management Server (BAMS) you 
are using, and select the BAMS configuration, if applicable.

Note VSPT 1.6 currently supports BAMS Phase 2 only. See the current release notes for this application 
for further information about future support for BAMS Phase 3.

Step 8 Enter the network addresses (IP Addr: 1 and IP Addr: 2) in dotted notation; for example, 172.18.145.3, 
or click Import Settings to import the network addresses.

Step 9 Indicate whether the MGC has a failover MGC and, if it does, enter the network addresses (Failover 
IP Addr: 1 and Failover IP Addr: 2). 

Click Modify. The hierarchical tree displaying “Unknown MGC” changes to the MGC host name you 
entered in Step 5, (see Figure 3-3), and “Modification complete” is displayed briefly on the bottom left 
section of the screen.
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Figure 3-3 MGC Host Added

Adding Ethernet Cards and Interfaces
Interfaces components identify connections to the network Ethernet cards or adapters installed in the 
Cisco MGC host. They permit IP communication between the Cisco MGC and the Cisco SLTs.

Table 3-2 lists interface properties. Use the values in the table as you add interfaces to your MGC.

Table 3-2 Interface Properties

Property MML Parameter Description Default Valid Values

Name name Identifies a physical card in the MGC Card-x Up to 80 
alphanumeric 
characters

Description desc Describes the adapter card Card Up to 128 
alphanumeric 
characters
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Perform the following steps to add an Ethernet interface to the Cisco MGC. If necessary, refer to 
Table 3-2 for property values.

Step 1 Click Interfaces in the right pane of the main VSPT window. The screen shown in Figure 3-4 appears.

Figure 3-4 Adding Interface Cards

Step 2 Enter the interface name.

Step 3 Enter a description for the interface.

Step 4 Select the card type.

Step 5 Select the slot in which the card is installed.

Step 6 Click Add. The hierarchical tree on the left pane of the main VSPT window changes to reflect the card 
you added. 

Step 7 Click the Ethernet interface card you are configuring on the hierarchical tree on the left pane of the main 
VSPT window. The screen shown in Figure 3-5 appears.

Type type Identifies the type of adapter card in the MGC Ethernet Ethernet—Ethernet 

ATM—ATM card

ITK—E1/T1 card

V35—V.35 card

Slot slot Identifies the physical slot in which the adapter card is 
installed

0 0 through 3

Table 3-2 Interface Properties (continued)

Property MML Parameter Description Default Valid Values
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Figure 3-5 Adding an Interface

Step 8 Click Add Interface. The screen shown in Figure 3-6 appears.

Figure 3-6 Interface Parameters

Step 9 Enter a name.

Step 10 Enter a description.

Step 11 The Card field contains the name of the card for which you are adding an interface. Verify that you have 
selected the correct card.

Step 12 Click Add. 

Step 13 Repeat Step 7 through Step 12 for each card you configured.
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Configuring SS7 Signaling Services
SS7 signaling services identify all signaling types processed by the Cisco MGC. To configure SS7 
signaling services, you must:

• Add Point Codes, page 3-8

• Add Linksets, page 3-11

• Add C7 IP Links, page 3-14

• Add SS7 Subsystems (Mated Pairs), page 3-17

• Configure SS7 Paths, page 3-20

• Configure SS7 Routes, page 3-22

Adding Adjacent Point Codes
Adjacent point codes (APCs) are the SS7 network addresses of the STPs (or SSP directly connected to 
the SLT) that connect to the MGC node. The MGC node communicates with external SSPs and SCPs 
through an STP. 

Table 3-3 lists the APC properties. Use the values in the table as you add APCs to the Cisco MGC.

Use the following procedure to add the APCs for STPs. Where necessary, refer to Table 3-3 for property 
values.

Step 1 Click the icon next to Signaling to expand the hierarchical tree in the left pane of the main VSPT 
window, and click APCs. The screen shown in Figure 3-7 appears.

Table 3-3 APC Properties

Property MML 
Parameter

Description Default Valid Values

Name name Identifies the adjacent point code MML name. STP-x Up to 80 alphanumeric 
characters

Description desc Describes the point code. Use up to 128 
alphanumeric characters.

APC Up to 128 alphanumeric 
characters

NetAddr netaddr Enter point code in this field. Valid for both ITU 
and North American point codes.

0.0.0 User defined

NetIndicator netind Identifies the type of node receiving the point 
code.

National International 
(reserved for 
international) or
National
(reserved for national)
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Figure 3-7 Adding Adjacent Point Codes

Step 2 Enter the name. (For example, STP-1.)

Step 3 Enter the description. (For example, Adjacent Point Code.)

Step 4 Enter the network address in dotted notation (for example, 172.18.145).

Step 5 On the NetIndicator drop-down menu, select the desired value:

• International network—Used if the node is an international gateway.

• Spare (for international use)—Used in countries where multiple carriers share point codes; networks 
are differentiated by this indicator.

• National network—Used if the node routes calls through the national network.

• Reserved—For national use. Do not use.

Step 6 Click Add. The hierarchical tree in the left pane of the main VSPT window changes to reflect the 
adjacent point code you added (STP-1). 

Step 7 To add additional APCs, repeat Step 1 through Step 6 for each APC.

Add Point Codes
Every signaling point in the SS7 network is identified by a unique point code. Provision point codes 
using the following subsections:

• Add Destination Point Codes, page 3-9

• Add Origination Point Code, page 3-10
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Note Point codes provide the basis for the addressing scheme for the SS7 network. ITU point codes contain 
14 bits, and ANSI point codes contain 24 bits.

Add Destination Point Codes 

A destination point code (DPC) is an SS7 network address that identifies an SS7 network node, such as 
an STP, SSP, or media gateway, with which the MGC node communicates.

Use the following procedure to add the DPCs for the ILEC and CLEC switches:

Step 1 Click Signaling > Point Codes on the left pane of the main VSPT window. A screen similar to that 
shown in Figure 3-8 appears.

Figure 3-8 Adding DPC

Step 2 Enter the DPC name.

Step 3 Enter the description of the DPC.

Step 4 Enter the network address of the DPC in dotted notation, for example, 172.18.145.3.

Step 5 On the NetIndicator drop-down menu, select the network indicator:

• International network—Used if the node is an international gateway (default value).

• Spare (for international use)—Used in countries where multiple carriers share point codes; networks 
are differentiated by this indicator.

• National network—Used if the node routes calls through the national network.

• Reserved—For national use. Do not use.
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Step 6 Click Add. The hierarchical tree in the left pane of the main VSPT window changes to reflect the 
destination point code you added.

Add Origination Point Code

The origination point code (OPC) is an SS7 network address that identifies a Cisco MGC. Use the 
following procedure to configurate the OPCs for the Cisco MGC:

Step 1 Click Signaling > Point Codes > OPC in the left pane of the main VSPT window. A screen similar to 
the one shown in Figure 3-9 appears:

Figure 3-9 Add OPC

Step 2 Enter the name of the OPC.

Step 3 Enter the description of the OPC.

Step 4 Enter the net address of the OPC, and specify whether it is ANSI or ETSI.

Step 5 On the NetIndicator drop-down menu, select the desired value:

• International network—Used if the node is an international gateway.

• Spare (for international use)—Used in countries where multiple carriers share point codes; networks 
are differentiated by this indicator.

• National network—Used if the node routes calls through the national network.

• Reserved—For national use. Do not use.

Step 6 Click Modify. The hierarchical tree in the left pane of the main VSPT window changes to reflect the 
OPC you added. 
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Add Linksets
A linkset is a logical group of links that transport SS7 signals to the Cisco MGC. Linksets can consist 
of the following:

• Links from the Cisco MGC (OPC) to an adjacent STP (APC)

• Links from the Cisco MGC (OPC) to a destination (a DPC acting as an APC, if there is no STP)

Table 3-4 lists linkset properties. Use the values in the table as you add linksets to your MGC.

Use the following procedure to add the linksets between the MGC node and the STPs. Where necessary, 
refer to Table 3-4 for property values:

Step 1 Click LinkSets. The screen shown in Figure 3-10 appears.

Table 3-4 Linkset Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the linkset MML name

Must start with an alphabetical character.

Lnkset-x Up to 10 
alphanumeric 
characters

Description desc Describes the linkset Lnkset Up to 128 
alphanumeric 
characters

Point Code apc Identifies the adjacent point codes components for the 
SS7 node providing the linkset

<UNSET> User defined.

Protocol proto Identifies the protocol family associated with this 
linkset

SS7-ANSI SS7-ITU
SS7-ANSI
SS7-UK
SS7-China
SS7-Japan

Type type Indicates how the signaling link is terminated on the 
Cisco MGC

IP IP (when SLTs 
and used)

TDM (when 
adapter cards are 
used)
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Figure 3-10 Adding Linksets

Step 2 Enter the linkset name. (For example, Linkset-1.)

Step 3 Enter the description of the linkset. (For example, Linkset.)

Step 4 On the Point Code drop-down menu, select the desired APC or DPC component for this linkset. (For 
example, STP-1.)

Step 5 On the Protocol drop-down menu, select the desired protocol:

• SS7-ANSI

• SS7-China

• SS7-ITU

• SS7-Japan

• SS7-UK

Step 6 On the Type drop-down menu, select the link termination type.

Step 7 Click Add. The hierarchical tree in the left pane of the main VSPT window changes to reflect the linkset 
you added.

Note After creating the linksets, you must create the links in each linkset by adding C7 IP links. 
Refer to the “Add C7 IP Links” section on page 3-14.
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Adding and Changing Linkset Properties

You can add and change the properties of a linkset after it is created, including message and timer values. 
Changes apply to all linksets you create. You do not have to change the default properties. For a list of 
linkset properties, default values, and descriptions, see the Cisco Media Gateway Controller Software 
Release 7 Provisioning Guide.

Perform the following steps to add or change linkset properties:

Step 1 Highlight the appropriate linkset in the left pane, and click Properties to display the list of properties. 
The screen shown in Figure 3-11 appears.

Figure 3-11 Adding and Changing Linkset Properties

Step 2 To add a property, select the property in the Name drop-down list, enter a value in the Value text box, 
and click Add. The screen shown in Figure 3-12 appears, with the property and value added. After a 
property has been added, its value can be modified.
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Figure 3-12 Linkset Property Added

Step 3 To modify an existing property, click the name of the property in the screen shown in Figure 3-11.

Step 4 In the value field, overwrite the property value with the desired value.

Step 5 Click Modify.

Step 6 Click OK when you are finished modifying properties.

Note You cannot modify properties until after you have created the linkset.

Add C7 IP Links

You must configure links for all physical connections bearing signals that enter and exit the Cisco MGC. 
This includes SS7 signals from the SSP (ILEC switch) and signal links to the media gateway.

A C7 IP link component identifies one link within a linkset that enters the Cisco MGC through an SLT. 
Table 3-5 lists the C7 IP link properties. Use the values in the table as you add links to linksets.
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Add a C7 IP link for each physical SS7 link that is connected to the SS7 network through the Cisco SLT. 
Each link corresponds to a linksets you created in the “Add Linksets” section on page 3-11.

Use the following procedure to add C7 IP links. Where necessary, refer to Table 3-5 for property values.

Step 1 Under LinkSets, in the left pane of the main VSPT window, click Lnkset-1 (the linkset you created in 
the “Add Linksets” section on page 3-11). The screen shown in Figure 3-13 appears.

Table 3-5 C7 IP Link Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the MML name for the link. C7ip-1 Up to 10 
alphanumeric 
characters, 
beginning with an 
alpha character

Description desc Describes the link.

Up to 128 alphanumeric characters. 

C7Iplink Up to 128 
alphanumeric 
characters

Interface if Selects the interface on which the link is entering 
the VSC3000.

<UNSET> User defined

IP Addr ipaddr Identifies the IP address of the VSC3000 set in the 
IP_Addr field in the XECfgParm.dat file.

<UNSET> Addr1
Addr2
Addr3
Addr4

Port port Identifies the UDP port of the VSC3000 that 
listens for the signaling communications.

7000 Any non-well 
known UDP port 
greater than 1024

Priority pri Identifies the priority value of the link. 1 1 through 4 

Give links the same 
priority for load 
sharing

Peer Address peeraddr Identifies the IP address of the Cisco SLT. None User defined

Linkset lnkset Displays the linkset to which this link belongs. None User defined

SLC slc Unique identifier for the link.

Corresponds to the Signaling Link Code (SLC) 
received from the carrier.

0 0 through 15

SLT Port sltport Identifies the WIC port of the Cisco SLT for the 
link.

0 0 through 3

IP Gateway ipgateway Identifies the IP address, in dotted decimal 
notation, of the gateway.

None x.x.x.x

IP Net Mask ipnetmask Identifies the IP net mask, in dotted decimal 
notation, of the gateway.

None x.x.x.x
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Figure 3-13 Adding C7 IP Links

Step 2 Enter the name.

Step 3 Enter the description.

Step 4 On the Interface drop-down menu, select the Ethernet interface for this link.

Step 5 On the IP Addr drop-down menu, select the IP address of the Cisco MGC:

• Addr1

• Addr2

• Addr3

• Addr4

Note The numbered address for this value is found in the XECfgParm.dat file you set up during 
your initial system configuration. See the Cisco Media Gateway Controller Software Release 
7 Installation and Configuration Guide for more information.

Step 6 Enter the number of a UDP port on the Cisco MGC. You can use any unused UDP port number, but you 
should not use ports 1 through 1024 (these are reserved for other applications).

Step 7 Enter a priority. The value range is 1 through 4, and 1 is the highest priority.

Note To enable loadsharing, use the same priority (1) for each C7 IP link. Traffic is routed equally 
over the links is there is a failure.

Step 8 Enter the IP address of the Cisco SLT in the peer address field. 
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Note You do not enter a peer port value, because the actual peer port value is found in the *.stPort 
field in the XECfgParm.dat file you set up during your initial system configuration. See the 
Cisco Media Gateway Controller Software Release 7 Installation and Configuration Guide 
for more information.

Step 9 Click Linkset, and choose the linkset for this link.

Step 10 Enter the appropriate signaling link code (SLC) for the line between the Cisco SLT and the STP. The 
SLC can be any integer from 0 through 15.

Step 11 Enter the SLT port. This is the physical port on the Cisco SLT.

Note The SLT port number must be unique for a given link on a particular Cisco SLT. For 
example, if you have a 2T WAN interface card (WIC) in slot 0 of the Cisco SLT, you can use 
port value 0 for the first link you configure. The second link on that WIC uses the port value 
1.

Step 12 Enter the IP address of the gateway in the IP Gateway field.

Step 13 Enter the subnet mask of the gateway in the IP Net Mask field.

Step 14 Click Add. The hierarchical tree in the left pane of the main VSPT window changes to reflect the C7 IP 
link you added.

Add SS7 Subsystems (Mated Pairs) 
An SS7 subsystem allows the Cisco MGC to route traffic over the C-links between mated STPs to 
provide network reliability. The links to these STPs are defined in the “Add Linksets” section on 
page 3-11.

The SS7 subsystem provides local number portability (LNP) support through an SCP. Because the SS7 
subsystem is an instance of an application, you need to configure a subsystem for each application type 
of service (for example, LNP). The SS7 subsystem is also used to connect an STP to an SCP database 
for AIN queries. In this case, there is no mated STP.

Table 3-6 lists SS7 subsystem properties. Use the values in the table as you add SS7 subsystems to your 
MGC.

Table 3-6 SS7 Subsystem Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the MML name for this SS7 subsystem. Ss7ss-1 Up to 80 
alphanumeric 
characters.

Description desc Describes the subsystem. SS7 Subsystem Up to 128 
alphanumeric 
characters.

Subsystem 
Type

Identifies the type of subsystem. None Mating APCs

AIN Services
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Use the following procedure to add SS7 subsystems for the STPs. Where necessary, refer to Table 3-6 
for property values.

Step 1 Click Signaling > SS7Subsystems in the left pane of the main VSPT window. The screen shown in 
Figure 3-14 appears.

Figure 3-14 Adding Mated pairs

TCAPIP or 
APC

svc Identifies the STP (or STP pair)  to be used for 
TCAP messages.

<UNSET> User defined.

Priority pri Identifies the priority value of the route.  Used for 
load sharing.

1 1 through 16

Subsystem 
number

ssn Identifies the desired SCP services.  The value is 
provider specific.

0 x.x.x.x

STP/SCP 
Index

stpscpind Identifies each SCP in a virtual switch 
configuration.

0 0 through 99

Transport 
Protocol

transproto Identifies the transport protocol used for TCAP 
messages.  Accessing SCPs with SS7 uses the SCCP 
protocol.

TCP/IP SCCP

TCP/IP

Protocol 
Family

proto Identifies the protocol family used for SS7 
messages.

<UNSET> SS7-ANSI

SS7-ITU

Table 3-6 SS7 Subsystem Properties (continued)

Property MML Parameter Description Default Valid Values
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Step 2 Enter the name.

Step 3 Enter the description.

Step 4 Select the appropriate radio button for the subsystem type you are adding. If you are identifying mated 
STPs, click the Mating APCs button. If you are using the subsystem for AIN queries, click the AIN 
Services button. In this example we are mating APCs. After you click the Mating APCs button, the 
screen displayed in Figure 3-15 appears:

Figure 3-15 Configure Mated Subsystem

Step 5 Enter the name.

Step 6 Enter the description.

Step 7 Select the subsystem type.

Step 8 On the Mated APC drop-down menu, select the APC of the second STP of the mated pair.

Step 9 On the Transport Protocol drop-down menu, click TCPIP when identifying mated STPs. For AIN, click 
SCCP or TCPIP.

Step 10 On the Protocol Family drop-down menu, select the protocol family:

• SS7-ANSI—Use when identifying mated STPs or using the subsystem for AIN queries.

• SS7-China 

• SS7-ITU—Use when identifying mated STPs or using the subsystem for AIN queries

• SS7-Japan

• SS7-UK.
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Note If you have multiple linksets to an STP that use different protocol families, you must also 
have multiple SS7 subsystems, one for each linkset that uses a specific protocol.

Step 11 Click Add. The hierarchical tree on the left pane of the main VSPT window changes to reflect the mated 
pair you added.

Configure SS7 Paths 
An SS7 signaling service identifies the path over which the MGC node communicates, using a specific 
protocol, with a remote MGC or switch. The MML component name is SS7PATH. Table 3-7 lists the 
SS7 signaling service properties. Use the values in the table as you add SS7 paths to your MGC.

Use the following procedure to add SS7 signaling service paths to the switch (identified by the DPC). If 
you have a signaling service from the Cisco MGC to a PSTN switch, use the SS7 path component to add 
the service to your configuration. Where necessary, refer to Table 3-7 for property values.

Step 1 Click SS7 Paths in the left pane of the main VSPT window. The screen shown in Figure 3-16 appears.

Table 3-7 SS7 Signaling Service Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the SS7 service path. None Up to 10 
alphanumeric 
characters.

Description desc Describes the SS7 service path. None Up to 128 
alphanumeric 
characters.

Point Code dpc Specifies the point code of the SSP in the service path. <UNSET> User defined.

Side side Distinguishes the network equipment (like a switch) 
from the user equipment (like a terminal adapter or 
PBX). (Used for ISDN systems.)

network Network
User

MDO mdo Identifies the protocol (MDO file name) for this SS7 
service path. You select the MDO file name from a 
drop-down list.

ANSISS7_S
TANDARD

See list.

Customer 
Group ID

custgrpid Contains a unique identifier for the number analysis 
file. (Used with nailed solutions only.)

0000 000–9999 Up 
to 4-digit 
alphanumeric 
charactrers.

Customer 
Group Table

custgrptbl Contains the number analysis table index used in 
combination with the Customer Group ID as a unique 
key to identify the number analysis file used for this 
signal service. (Not currently used.)

0101 0000–9999
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Figure 3-16 Adding SS7 Paths

Step 2 Enter the name of the SS7 signaling path.

Step 3 Enter the description of the SS7 signaling path.

Step 4 On the Side drop-down menu, select the side (Q.931 call model side):

• Network

• User

Step 5 On the Point Code drop-down menu, select the destination point code (the point code of the PSTN 
switch) for this signaling service.

Step 6 On the MDO drop-down menu, select the protocol for this signaling service; for example, 
ANSISS7_STANDARD. Supported protocols are:

• ANSISS7_CLEAR

• ANSISS7_MCI

• ANSISS7_SPRINT

• ANSISS7_STANDARD

• BTNUP_BTNR167

• BTNUP_IUP

• BTNUP_NRC

• ETS_300_356

• HKTA_2202

• ISUPV1_POLI

• ISUPV2_FINNISH96

• ISUPV2_FRENCH

• ISUPV2_GERMAN
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• ISUPV2_JAPAN

• ISUPV2_KPNPB

• ISUPV2_JAPAN

• ISUPV2_SWISS

• ISUPV3_UK

• NORTEL_IBN7

• Q721_BASE

• Q721_CHINA

• Q721_FRENCH

• Q761_ARGENTINA

• Q761_AUSTRL

• Q761_BASE

• Q761_BELG_MOBI

• Q761_CHILE

• Q761_CHINA

• Q761_KOREAN

• Q761_SINGAPORE

• Q761_TAIWAN

• Q767_BASE

• Q767_ITAL

• Q767_ITAL_INTERCONNECT

• Q767_MEXICAN

• Q767_RUSS

• Q767_SPAN

• Q767_SWED

• Q767_TELSTRA

• T113_BELL

Step 7 Enter the customer group ID.

Step 8 Enter the customer group table.

Step 9 Click Add. The hierarchical tree on the left pane of the main VSPT window changes to reflect the SS7 
path you added.

Configure SS7 Routes
An SS7 route is a path, through a linkset, between one MGC node and another MGC node or a switch. 
In the following example, the SS7 routes indicate the linksets that carry SS7 signals between the MGC 
node and the ILEC Class 5 switch or CLEC Class 5 switch.

You must define a separate route for each remote switch.
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Table 3-8 lists the SS7 route properties. Use the values in the table as you add SS7 routes to your MGC.

You must add an SS7 route for each signaling path from the Cisco MGC to the PSTN switch through the 
linksets you have created to the STPs. You should create two routes to the PSTN switch, with each route 
passing through a different STP of a mated pair.

Use the following procedure to add SS7 routes to the MGC. Where necessary, refer to Table 3-8 for 
property values.

Step 1 Click SS7 Routes in the left pane of the main VSPT window. The screen shown in Figure 3-17 appears.

Figure 3-17 Adding SS7 Routes

Table 3-8 SS7 Route Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the MML name for a route set. Ss7r-1 Up to 10 
alphanumeric 
characters

Description desc Description of the route. SS7 Route Up to 128 
alphanumeric 
characters

Originating PC opc Select the MML name of the MGC point code. <UNSET> User defined

Destination PC dpc Select the point code of the destination switch 
delivering bearer traffic to the solution.

<UNSET> User defined

Linkset lnkset Select the linkset over which the SS7 signals travel. <UNSET> User defined

Priority pri Sets the priority value of the route. Create load 
sharing by setting all routes to the same number.

1 1 through 4
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Step 2 Enter the name.

Step 3 Enter the description.

Step 4 On the Originating PC drop-down menu, select the origination point code for this route.

Step 5 On the Destination PC drop-down menu, select the signal destination point code of the PSTN switch.

Step 6 On the Linkset drop-down menu, select the linkset for this route.

Step 7 Enter the priority.

Note Routes can share signaling traffic. To enable load sharing, set the priorities the same for each 
route. 

Step 8 Click Add. The hierarchical tree on the left pane of the main VSPT window changes to reflect the SS7 
route you added.

Configure FAS Signaling
A facility associated signaling (FAS) service uses the same path for signaling and voice circuits. 
Table 3-9 lists the FAS signaling service properties. Use the values in the table as you add FAS signaling 
services to your MGC.

Table 3-9 FAS Signaling Service Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the MML name of the FAS 
signaling service.

Fas-1 Up to 10 
alphanumeric 
characters

Description desc Describes the FAS signaling service. Faspath signaling 
service

Up to 128 
alphanumeric 
characters.

Side side Distinguishes the network equipment 
from the user equipment.

network network

user

MDO mdo Identifies the protocol (MDO file name) 
for this FAS signaling service. You select 
the MDO file name from a drop-down 
list.

See list

Customer 
Group ID

custgrpid Contains a unique identifier for the 
number analysis file.

0000 0000–9999

Customer 
Group Table

custgrptbl Contains the number analysis table index 
used in combination with the customer 
group ID as a unique key to identify the 
number analysis file used for this signal 
service.

0101 0101
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Use the following procedure to configure FAS signaling for the Cisco MGC. Where necessary, refer to 
Table 3-9 for property values.

Step 1 Click Signaling > FAS Signaling in the left pane of the main VSPT window. The screen shown in 
Figure 3-18 is displayed.

Figure 3-18 Add FAS Signaling

Step 2 Click Add. The screen shown in Figure 3-19 is displayed.

A/B Flag abflag Specifies DPNSS a or b side. n A side 

B side

n—NA

Call Reference 
Length

crlen Identifies the field length (1 or 2 bytes) 
for the call reference number.

2—standard ETSI 0—DPNSS

1—1 byte

2—2 bytes

Table 3-9 FAS Signaling Service Properties (continued)

Property MML Parameter Description Default Valid Values
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Figure 3-19 Configure FAS Signaling

Step 3 Enter the name.

Step 4 Enter the description.

Step 5 On the Side drop-down menu, select the Q.931 call side model:

• Network

• User

Step 6 On the MDO File Name drop-down menu, select the protocol for this signaling service.

Step 7 Enter the customer group ID (formerly the VNETID).

Step 8 Enter the customer group table.

Step 9 On the A/B Flag drop-down menu, select a value.

Step 10 On the Call Reference Length drop-down menu, select 0, 1, or 2.

Step 11 Click Add. The hierarchical tree in the left pane of the main VSPT window changes to reflect the FAS 
signaling service you added.

Add or Modify FASPath properties

Use the following procedure to add or modify FASPath properties:

Step 1 Click Properties in the window shown in Figure 3-19. The screen shown in Figure 3-20 is displayed.
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Figure 3-20 FASPath Properties

Step 2 To add a property, select the property in the Name drop-down list.

Step 3 Enter the property value in the Value drop-down list.

Step 4 Click Add. The new property and value appear on the top portion of the screen.

Step 5 To modify a property, click the property you want to change.

Step 6 In the value field, overwrite the property value with the desired value.

Step 7 Click Modify.

Step 8 Click OK when you are finished adding or modifying properties.

Configuring Media Gateway Control Links
Media gateway (MGW) control links provide the communication path used by the signaling controller 
to control the bearer traffic passing through each media gateway. Configure MGW control links using 
the components in the following paragraphs.

Note You need to configure cards and interfaces for MGW control links just as you configured the cards 
and interfaces used for signaling links. You might be able to use the same cards and interfaces 
previously planned for your MGW control links. For information on configuring cards and 
interfaces, refer to the “Configuring the Cisco MGC” section on page 3-1.
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Adding External Nodes
An external node is a node with which the MGC communicates, either directly or indirectly. Here the 
media gateway is the external node. Table 3-10 lists the external node properties. Use the values in the 
table as you add external nodes to your MGC.

Use the external node component to add MGWs. You must create an external node for each MGW.

Note Cisco SLTs perform MTP layer 2 processing only, and you do not need to add them as external nodes 
when provisioning.

Use the following procedure to add an external node to the MGC. Where necessary, refer to Table 3-10 
for property values.

Step 1 Click External Node in the left pane of the main VSPT window. The screen shown in Figure 3-21 
appears.

Table 3-10 External Node Properties

Field Name MML Parameter Description Default Valid Values

Name name Identifies the MML name for the external node External-1 Up to 10 
alphanumeric 
characters; 
must start 
with a letter

Description desc Describes the external node. External Node Up to 128 
alphanumeric 
characters

Type type Lists the various external nodes supported. <UNSET> <UNSET>
AS3660 
AS5200 
AS5300 
AS5350 
AS5400 
AS5800 
AS5850 
AS7200 
CAT8510 
CAT8540 
LS1010 
MGC 

MGX8260 
SCP 
UNKNOWN 
VISM
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Figure 3-21 Adding External Nodes

Step 2 Enter the name.

Step 3 Enter the description.

Step 4 On the Type drop-down menu, select the type of external node you are adding. For example, click 
MGX8260, and click Add. The hierarchical tree in the left pane of the main VSPT window changes to 
reflect the external node that you added (for example, Cisco MGX 8260).

Configuring MGWs
An MGW is the interface between the QoS packet network and the PSTN/ISDN network. A gateway 
digitizes and compresses voice calls from the PSTN, creating IP packets for routing to another gateway 
(for forwarding to the PSTN) or to a terminal.

Note The conponents to be configured vary according to the type of external node you have added.

Table 3-11 lists the MGW properties. Use the values in the table as you configure MGWs.



 

3-30
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Chapter 3      Manual Provisioning with the VSPT
Configuring Media Gateway Control Links

Use the following procedure to configure the external node as an MGW. Where necessary, refer to 
Table 3-11 for property values.

Step 1 Click the external node that you just added, in the left pane of the main VSPT window. A screen similar 
to the one shown in Figure 3-22 appears.

Table 3-11 MGW Properties

Field Name Description Default Valid Values

Name MML name for external node <gateway name> Up to 80 
alphanumeric 
characters

Description Description of the external node. None Up to 128 
alphanumeric 
characters

Type Previously defined external node type. <MGX8260> User defined

MGX Hostname Identifies the target MGX8260’s IP address. None User defined

Login / Password Configures valid MGX login and password. None User defined

MGCP Domain Defines the domain name used by the VSC3000 when it sends 
MGCP connection messages that control bearer/trunk circuits.

None User defined

DS1 Type Specifies the DS1 as E1 (Europe) or T1 (North America). T1 E1
T1

IP Address #1 IP address, in dotted decimal notation, of the MGX’s primary 
IP interface, used for signaling and control.

None x.x.x.x

IP Subnet Mask #1 Defines the IP mask, in dotted decimal notation, for this IP 
interface.

None x.x.x.x

IP Address #2 IP address, in dotted decimal notation, of a secondary interface 
used for signaling or control backup.

None x.x.x.x

IP Subnet Mask #2 Defines the IP mask for this IP interface. None No, Yes

Clock Source Slot Identifies the card slot on the MGX 8260 that is providing the 
timing source.  Ignored if internal clock is selected.

9 9–16

Clock Source Line Identifies the DS1/DS3 line number from which timing is 
derived. Ignored if internal clock is selected.

1 (if slot 9–10

501 (if slot 11-16)

1–16

501–06

Clock Source Type Defines the source for timing. external broadband
narrowband
external
internal

Clock Src Card Type External clock can be derived from the Building Integrated 
Timing Source (BITS) input or an OC–3 optical input on the 
SCC card.  Ignored if internal clock is selected.

bits bits
oc3

Rack Number Physical identification of rack. <UNSET> 1–7

Network Mode Determines how the MGC node is used. Local local
VoATM
VoIP
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Figure 3-22 Configuring an MGW

Step 2 Enter a name for the external node

Step 3 Enter a description of the external node.

Step 4 Enter an IP address in the MGX 8260 Hostname field.

Step 5 Enter a valid Cisco MGW login ID and password.

Step 6 Enter the gateway domain.

Note You can import settings from the Cisco MGW you specified with the MGX 8260 hostname 
by clicking Import Settings. You see the screen shown in Figure 3-22 while the settings are 
being imported.

Step 7 Click Properties. The screen shown in Figure 3-23 appears.
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Figure 3-23 Properties

Step 8 On the Clock Source Slot, Clock Source Line, Clock Source Type, and Clock Src Card Type drop-down 
menus, select the desired value for each, and click OK.

Step 9 If you did not import the settings, enter the network addresses and masks (IP Address #1, IP Subnet Mask 
#1, IP Address #2, and IP Subnet Mask #2) in dotted notation; for example, 172.18.145.3.

Step 10 Click Modify. The hierarchical tree in the left pane of the main VSPT window changes to reflect the 
MGW you added. 

Adding a Broadband or Narrowband Service Card
A broadband switching card (BSC) provides high density TDM switching capability to the MGX8260. If a 
BSC is installed in the external gateway, provision it beginning with Step 1, below. If a narrowband 
service card (NSC) is installed, start with Step 5. 

Step 1 Expand the tree under the MGW in the left pane of the main VSPT window, and click BSC. A screen 
similar to the one shown in Figure 3-24 appears.
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Figure 3-24 Configured BSCs

Step 2 Select the slot number of the card in the Slot Number drop-down list.

Step 3 Indicate whether it is a secondary redundant card, and select the appropriate DS3 line numbers. 

Step 4 Click Add, to add the BSC.

Step 5 To provision an NSC installed in the external gateway, expand the tree under the media gateway, and 
click NSC. The screen shown in Figure 3-25 appears.
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Figure 3-25 Add an NSC

Step 6 Select the slot number of the NSC in the Slot Number drop-down list.

Step 7 Select one or more DS1 lines by clicking on them to highlight them.

Step 8 To automatically provision the DS0s on the line, click the Provision DS0s checkbox.

Step 9 Indicate whether the card is a secondary redundant card.

Step 10 Click Add. The hierarchical tree in the left of the screen changes to reflect the service card you added.

Adding an IPFAS Signaling Service
An Internet Protocol Facility Associated Signaling (IPFAS) signaling service defines the FAS or NFAS 
over IP transport service or signaling path from a MGC node to a media gateway. Table 3-12 lists the 
IPFAS signaling service properties.

Table 3-12 IPFAS Signaling Service Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the MML name of the IPFAS service 
path.

Ipfas-1 Up to 10 
alphanumeric 
characters.

Description desc Describes the IPFAS service path. Ipfaspath 
signaling service

Up to 128 
alphanumeric 
characters.
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Use the following procedure to add the ipfaspaths from the media gateway. The MML component name 
is IPFASPath. In the following example, it is the PRI backhaul path from the media gateway. Where 
necessary, refer to Table 3-12 for property values.

Step 1 Click IPFAS in the left pane of the main VSPT screen, and click Add under the first textbox in the right 
pane. The screen shown in Figure 3-26 appears.

External 
Node

extnode Identifies the external node. None User defined.

Up to 10 
alphanumeric 
characters; 
cannot start 
with a number.

Side side Distinguishes the network equipment (like a 
switch) from the user equipment (like a terminal 
adapter or PBX). (Used for ISDN systems.)

network network

user

MDO mdo Identifies the protocol (MDO file name) for this 
IPFAS service path. You select the MDO file 
name in a drop-down list.

Bell_1268 See list.

Customer 
Group ID

custgrpid Contains a unique identifier for the number 
analysis file. (Used with nailed solutions only.)

0000 0000 – 9999

Customer 
Group Table

custgrptbl Contains the number analysis table index used in 
combination with the customer group ID as a 
unique key to identify the number analysis file 
used for this signal service. (Not used with this 
release.)

0101 0101

A/B Flag abflag Specifies DPNSS a or b side

(Field is ignored for ETSI.)

n A side
B side
n–NA

Call 
Reference 
Length

crlen Identifies the field length (1 or 2 bytes) for the 
call reference number. 

2—standard ETSI 0—DPNSS
1—1 byte
2—2 bytes 

Table 3-12 IPFAS Signaling Service Properties (continued)

Property MML Parameter Description Default Valid Values
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Figure 3-26 Adding an IPFAS Signaling Service

Step 2 Enter the name.

Step 3 Enter the description.

Step 4 On the Side drop-down menu, select the side (Q.931 call model side):

• Network

• User

Step 5 On the MDO File Name drop-down menu, select the protocol for this signaling service; for example, 
BELL_1268 or ATT_41459. Supported protocols are:

• ATT_41459          

• ATT_41459_C2    

• BELL_1268               

• BELL_1268_C3             

• ETS_300_102   

• ETS_300_102_C1       

• ETS_300_121           

• ETS_300_172            

• NTT_INS_1500 

Step 6 Enter the customer group ID (formerly VNETID).

Step 7 On the A/B Flag drop-down menu, select a value.
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Step 8 On the Call Reference Length drop-down menu, select 0, 1, or 2.

Step 9 On the MGW Card Slot drop-down menu, select a value.

Step 10 On the DS1 start drop-down menu, select a value.

Step 11 Enter a step interval.

Step 12 Enter the number of IPFASPaths to create multiple IPFASPaths.

Note You cannot have more than 168 IP links using the same UDP connection (same local port, 
local IP address, remote port, and remote address).

Step 13 Click Add. The top portion of the screen changes to reflect the IPFAS signaling service you added, and 
the D channel for the IP FAS signal path is displayed in the lower portion of the screen (see Figure 3-27).

Note Each FAS PRI defined in the Cisco MGW requires its own IPFASPath. Define an IPFASPath 
for each PRI D channel on the Cisco MGW.

Figure 3-27 IPFAS Signaling Service Added

Adding IP Links for IPFAS 

AN IP link for IPFAS identifies the IP link connection to support the IPFAS service between an MGC 
node Ethernet interface and an MGW. Table 3-13 lists the IP link properties. Use the values in the table 
as you add IP links to the MGC.
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Use the following procedure to add IPFASPath IP links. Where necessary, refer to Table 3-13 for 
property values.

Step 1 Highlight the IPFAS signaling path in the top pane of the window shown in Figure 3-27, and click the 
Add button in the lower pane of the window. The window shown in Figure 3-28 appears. 

Table 3-13 IP Link Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the MML name for the IP link. Mgcp-1-1 Up to 80 
alphanumeric 
characters

Description desc Describes the link.

Up to 128 alphanumeric characters.

Iplink#1 to 
Mgcp-1

Up to 128 
alphanumeric 
characters

Interface if Select the interface used for VSC to gateway 
communications.

None User defined

IP Addr ipaddr Identifies the IP address of the VSC set at the 
IP_Addr fields in the XECfgParm.dat file.

IP_Addr1 IP_Addr1

IP_Addr2

IP_Addr3

IP_Addr4

Port port Identifies the UDP port on the VSC for gateway 
communications.

2427 Any non-well 
known UDP port 
greater than 1024

Priority pri Identifies the priority value of the link. Give links 
same priority for load sharing

1 1

Peer 
Address

peeraddr Identifies the IP address configured for the 
gateway.

x.x.x.x User defined

Peer Port peerport Identifies the port on the gateway that receives 
messages.

2427 Any non-well 
known UDP port 
greater than 1024

Signal Slot sigslot Identifies the physical slot of the card that 
supports the IPFAS D-channel.

This value is only used to support IPFAS.

0 0—none

1 through 16

Signal Port sigport Identifies the DS1 port that is carrying the PRI 
D-channel (Q.931 signaling).  This value is only 
used to support IPFAS.

0 0—none

1 through 336

Service svc Identifies the signaling service that this link 
supports.

None User defined
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Figure 3-28 Add an IP Link

Step 2 Enter the name.

Step 3 Enter the description.

Step 4 On the Interface drop-down menu, select the Ethernet interface for this link. 

Step 5 On the IP Addr drop-down menu, select the IP address of the Cisco MGC.

• IP Addr1

• IP Addr2

• IP Addr3

• IP Addr4

Note The address for this value, in dotted decimal notation, is found in the XECfgParm.dat file 
you set up during your initial system configuration. See the Cisco Media Gateway Controller 
Software Release 7 Installation and Configuration Guide for more information.

Step 6 Enter a number for the UDP port on the Cisco MGC. You can use any unused UDP port number, but you 
should not use 1 through 1024 (these are reserved for other applications).

Step 7 On the Priority drop-down menu, select a priority. The value range is 1 through 4, and 1 is the highest 
priority.

Step 8 On the Peer Address drop-down menu, select the peer address.

Step 9 Enter the port number in the peer port field.

Step 10 On the Signal Slot and Signal Port drop-down menus, select values.
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Caution Because of a 0-based and 1-based addressing issue, the SigSlot number does not correspond to the 
card number on the Cisco MGW, and the SigPort number does not correspond to the DS1 number on 
the Cisco MGW. 

Step 11 Enter the IP gateway and the IP net mask.

Step 12 Click Add. The new IP links for the IP FAS signaling path appear in the lower portion of the window.

Step 13 Continue adding IP links to the IP FAS signaling paths, as needed.

Changing IPFAS Signaling Service Properties

You can modify the properties of the IPFAS signaling services you have created. These properties apply 
to all IPFAS signaling services you create. You do not have to change the default properties. For a list 
of signaling service properties, default values, and descriptions, see the Cisco Media Gateway 
Controller Software Release 7 Provisioning Guide.

Use the following procedure to add or change IPFAS signaling service properties:

Step 1 On the screen shown in Figure 3-27, select a IPFAS signaling service on the top portion of the screen, 
and click Modify. The screen shown in Figure 3-29 appears.

Figure 3-29 Adding and Changing IPFAS Signaling Properties

Step 2 To modify the IPFAS path configuration, change the property on this screen.

Step 3 To modify a property, click Properties. The screen shown in Figure 3-30 appears.
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Figure 3-30 IPFAS Signaling Service Property Added

Step 4 To add a property, select the property in the Name drop-down list.

Step 5 Enter the property value in the Value drop-down list.

Step 6 Click Add. The new property and value appear on the top portion of the screen.

Step 7 To modify a property, click the property you want to change.

Step 8 In the value field, overwrite the property value with the desired value.

Step 9 Click Modify.

Step 10 Click OK when you are finished adding or modifying properties.

Note You cannot modify properties until after you have created the IPFAS signaling service.

Adding an MGCP Signaling Service
The MGCP signaling service specifies the path that the MGC node uses to communicate with an MGW. 
The MML component name is MGCPPATH. Table 3-14 lists the MGC signaling service properties. Use 
the values in the table as you add an MGCP signaling service.
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Note You must set the mgcpDomainNameRemote and mgcpHeartbeatInterval properties for all MGCP 
signaling services defined in your Cisco MGC. For more information, see the “Adding and Changing 
MGCP Signaling Service Properties” section on page 3-43.

Use the following procedure to add MGCP signaling service paths to the MGW. Where necessary, refer 
to Table 3-14 for property values.

Step 1 Click MGCP on the left pane of the main VSPT screen. The screen shown in Figure 3-31 appears.

Figure 3-31 Adding MGCP Signaling Service

Step 2 Enter the name.

Step 3 Enter the description.

Table 3-14 MGC SIgnaling Service Properties

Property MML Parameter Description Default Valid Values

Name name Identifies the MML name for the MGCP signaling 
service.

Mgcp-1 Up to 10 
alphanumeric 
characters

Description desc Describes the service path. Mgcppath 
Signaling Service

Up to 128 
alphanumeric 
characters

External 
Node 

extnode Identifies the gateway for this signaling service. None User defined
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Step 4 Click Add. The hierarchical tree in the left pane of the main VSPT window changes to reflect the MGCP 
link you added.

Adding and Changing MGCP Signaling Service Properties

Add or change the properties of the signaling service you have created. Your additions or changes are 
applied to all signaling services you create. You do not have to change the default properties. For a list 
of signaling service properties, default values, and descriptions, see the Cisco Media Gateway 
Controller Software Release 7 Provisioning Guide.

You must set the following properties for all MGCP signaling services defined in your Cisco MGC:

• mgcpDomainNameRemote = heartbeat@media gateway MGCP domain name

The media gateway MGCP domain name is a property of the MGW object. You can derive the 
MGCP domain name from the MGCP path object because each MGCP path object refers to an 
external node and each external node refers to an MGW.

• mgcpHeartbeatInterval = 1

Use the following procedure to add or change MGCP signaling service properties:

Step 1 Highlight the MGCP signaling service you just added, and click Properties to display the list of 
properties. The screen shown in Figure 3-32 appears.

Figure 3-32 Adding and Changing MGCP Signaling Properties

Step 2 If you want to add a property, select the property from the Name drop-down list, enter a value, and click 
Add. The screen shown in Figure 3-33 appears with the property added.
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Figure 3-33 MGCP Signaling Service Property Added

Step 3 To modify a property, click the property you want to change.

Step 4 In the value field, overwrite the property value with the desired value.

Step 5 Click Modify.

Step 6 Click OK when you are finished.

Note You cannot modify properties until after you have created the MGCP signaling service.

Add an IP Link for MGCP 

An IP link for MGCP identifies the connection that supports the MGCP service between an MGC 
Ethernet interface and a media gateway. Use the following procedure to add an MGCP IP link:

Step 1 In the left pane of the main VSPT window, expand the tree under MGCP, highlight the signaling service 
for which you want to add an IP link, and click Links. The screen shown in Figure 3-34 appears.
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Figure 3-34 Adding MGCP IP Links

Step 2 Enter the name.

Step 3 Enter the description.

Step 4 On the Interface drop-down menu, select the Ethernet interface for this link. 

Step 5 On the IP Addr drop-down menu, select the IP address of the Cisco MGC.

• IP Addr1

• IP Addr2

• IP Addr3

• IP Addr4

Note The numbered address for this value is found in the XECfgParm.dat file you set up during 
your initial system configuration. See the Cisco Media Gateway Controller Software 
Release 7 Installation and Configuration Guide for more information.

Step 6 Enter a number of the UDP port on the Cisco MGC. You can use any unused UDP port number (2427 is 
recommended for MGCP), but you should not use 1 through 1024 (these are reserved for other 
applications).

Step 7 On the Priority drop-down menu, select a priority. The value range is 1 through 4, and 1 is the highest 
priority.

Step 8 On the Peer Address drop-down menu, select the peer address.

Step 9 Enter the port number in the peer port field.
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Step 10 Verify that the Service field lists the MGCP service to which you want to add a link.

Step 11 Click Add. The hierarchical tree on the left of the screen changes to reflect the MGCP IP link you added.

Configuring Bearer Traffic
Bearer traffic includes information on the trunk groups, trunks, and trunk routing required by an MGC to 
direct calls. It uses this information in conjunction with a dial plan to perform number analysis and route 
selection.

A trunk is a speech path between any two switches. Trunks are DS0 endpoints; one trunk can ride on one 
DS0, or one DS0 can carry one trunk. A trunk group is a collection of DS0 circuits arranged so that 
dialing a single trunk number provides access to the entire trunk group, and a trunk route is a set of trunk 
groups.

The configuration example in this section uses SS7 and PRI trunks.

The two main scenarios you are likely to follow when setting up the MGC node for call routing are 
described in Table 3-15.

Table 3-15 Setting Up the MGC Node for Call Routing

If you want to: Perform these steps:

Create a new configuration • Add all of the trunk groups, one by one, using the instructions in the 
“Add a Trunk Group” section on page 3-48.

• Add all of the trunks to the configured trunk groups, trunk group by 
trunk group, using the instructions in the “Adding Trunks” section 
on page 3-51.

• Add all of the route groups, one by one, using the instructions in the 
“Adding Route Groups and Routes” section on page 3-54.

• Build a dial plan using the instructions in the Cisco Media Gateway 
Controller Software Release 7 Dial Plan Guide.

Modify an existing 
configuration

• Load the existing configuration into the VSPT:

– If you are modifying a local configuration, click File > Open, 
and specify the configuration you want to modify.

– If you are modifying a configuration on an MGC, click 
File > Import, and specify the configuration you want to 
import.

• Add, modify, or delete trunk groups using the instructions in the 
“Add a Trunk Group” section on page 3-48.

• Add or delete trunks on a trunk group basis, using the instructions 
in the “Adding Trunks” section on page 3-51.

• Add, modify, or delete route groups using the instructions in the 
“Adding Route Groups and Routes” section on page 3-54.

• Build a dial plan using the instructions in the Cisco Media Gateway 
Controller Software Release 7 Dial Plan Guide.
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Caution You must provision SS7 components before the PRI components. When trunk groups are provisioned 
by the importing of customer trunk group files, all of the existing trunk groups and trunks are deleted. 
PRI trunk groups and trunks are provisioned by the use of individual MML commands, which do not 
delete all of the existing trunk groups and trunks. If the PRI components are provisioned before SS7 
components, all of the PRI trunk groups and trunks are deleted.

Importing Trunk Groups and Trunks
You can import the trunk groups and trunks to make them available to the MGC. Consider importing a 
trunk group for initial provisioning only. When you import a trunk group, all of the existing trunk groups 
are replaced by the imported trunk groups, and all existing trunks are deleted. 

Note The trunk file must contain all trunks (CIC) in a trunk group.

Perform the following steps to import a trunk group or trunk:

Step 1 Click File > Import. The screen shown in Figure 3-35 appears.

Figure 3-35 Importing Files

Step 2 Click From File, and on the File type drop-down menu, select the type of file you want to import (see 
Figure 3-36).
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Figure 3-36 Imported File Type

Step 3 Enter the name of the file you want to import. If you do not know the name of the file, click Select. The 
screen shown in Figure 3-37 appears and displays a list of files available for importation.

Figure 3-37 Selecting the File to Import

Step 4 Locate the the file you want to import, and click Open. The screen shown in Figure 3-36 appears again, 
and the full path name of the file you selected appears in the file name box.

Step 5 Click OK. The file you selected is imported.

Add a Trunk Group

Tip For information about importing the trunk group file, see the “Importing Trunk Groups and Trunks” 
section on page 3-47.

Use the following procedure to add a trunk group:
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Step 1 Click the Traffic radio button in the top portion of the main VSPT screen.

Step 2 Click Trunk Groups > Add. The screen shown in Figure 3-38 appears.

Figure 3-38 Defining a Trunk Group

Note For a complete description of trunk group properties and values, refer to the Cisco Media Gateway 
Controller Software Release 7 Provisioning Guide.

Step 3 Enter the trunk group number.

Step 4 Enter the Common Language Location Identification (CLLI).

Step 5 On the Signal Service drop-down menu, select the type of signal service.

Step 6 On the Trunk Type drop-down menu, select the type of trunk.

Step 7 On the Queueable drop-down menu, indicate whether or not the trunk group can be queued.

Step 8 On the Select Sequence drop-down menu, select the sequence.

Step 9 On the VSF Priority drop-down menu, select the priority.

Step 10 Enter the customer group ID.

Step 11 To configure additional properties for this trunk group, click the Property button. A screen similar to 
the one displayed in Figure 3-39 appears.
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Figure 3-39 Trunk Group Properties
.

Step 12 Configure any of the properties displayed in this window by modifying the selected property value. 

Step 13 When you are done modifying properties, click OK to return to the previous window.

Step 14 Click OK. The screen shown in Figure 3-40 appears, with the trunk group added.
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Figure 3-40 Trunk Group Added

Note After you have added a trunk group, you cannot delete it if there are still trunks defined in the trunk 
group or if there are existing route groups that refer to the trunk group. To maintain the integrity of 
the data in the traffic configuration branch, you have to first delete all trunks in the trunk group and 
remove any references to the trunk group from the route groups; then you can delete the trunk group.

Adding Trunks
Use the following procedure to add trunks to a trunk group:

Step 1 Click Traffic > Trunks in the left pane of the main VSPT window, and click Add. The screen shown 
in Figure 3-41 appears.
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Figure 3-41 Adding a Trunk

Step 2 On the Trunk Group Number drop-down menu, select the number of the trunk group you are configuring.

Step 3 On the Gateway Name drop-down menu, select the gateway (external node). This step might not be 
required if the gateway can be determined by trunk group signaling.

Step 4 Enter the MGC domain name.

Step 5 Enter the first trunk CIC number.

Step 6 On the Slot Number drop-down menu, select the slot number.

Step 7 Enter the DS1 number.

Step 8 Enter the first DS0 number.

Step 9 Enter the DS1 type. The trunk type is displayed. 

Step 10 Click SS7, PRI FAS, or PRI NFAS, and enter the appropriate properties:

• SS7—Enter the number of trunk members.

• PRI FAS and PRI NFAS—Enter the number of trunk members and the number of the DS1 with the 
D channel.

Note For PRI, one channel is reserved for signaling (D channel). For FAS, it is channel 24. For 
NFAS, it is channel 24, but on only one DS1.
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Step 11 Enter the number of trunk members in the trunk group.

Step 12 Click More if you want to add more trunks into other trunk groups. 

Step 13 When you are done adding trunks to a trunk group, click Finish, and the screen shown in Figure 3-42 
appears.

Figure 3-42 Trunks Added

Deleting Trunks from a Trunk Group
Use the following procedure to delete individual trunks from a trunk group:

Step 1 On the Trunks Added screen shown in Figure 3-42, use the Trunk Group Number drop-down menu to 
select the trunk group from which you want to delete trunks.

Step 2 Select the individual trunks you want to delete:

• To delete all the trunks in a trunk group, click Delete All.

• To select a range of trunks, click on the first trunk in the range, hold down the Shift key, and click 
the last trunk in the range.



 

3-54
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Chapter 3      Manual Provisioning with the VSPT
Configuring Bearer Traffic

• To select nonsequential trunks, hold down the Control key, and click each trunk.

Step 3 When you have finished selecting trunks, click Delete to delete the selected trunks. A screen similar to 
the one displayed in Figure 3-43 is displayed.

Figure 3-43 Trunks Deleted

Adding Route Groups and Routes
A route group is a collection of routes going to the same endpoint. Define the route groups, and then 
associate a trunk group with each route group. Use the following procedure to add a route group:

Step 1 Click Routing in the left p ane of the main VSPT window, and click Add. The screen shown in 
Figure 3-44 appears.
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Figure 3-44 Adding a Route

Step 2 Enter a route group name.

Step 3 Enter a carrier ID.

Step 4 To associate the route group with a previously defined trunk group, select a group in the Available box, 
and click Select .

Tip To select more than one trunk group, hold down the Control key while you select each group.

Step 5 When you are done adding route groups, click OK. The screen shown in Figure 3-45 appears with the 
route groups added.



 

3-56
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Chapter 3      Manual Provisioning with the VSPT
Configuring Bearer Traffic

Figure 3-45 Route Group Added

Hierarchical View of Provisioned Components
The results of the provisioning session you completed are visible in the hierarchical tree in the left pane 
of the main VSPT screen. You can expand the branches to view individual component (see Figure 3-46).
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Figure 3-46 Hierarchical Tree of Components

Performing an Integrity Check
When provisioning is complete, you can perform an integrity check to prevent possible configuration 
errors. The integrity check verifies:

• Integrity for MGC signaling configuration

• Traffic against MGC configuration

• Dial plan results

Each integrity check is explained in more detail in the following subsections.

Checking Integrity for MGC Signaling Configuration
When you perform an integrity check for an MGC signaling configuration, the VSPT does the following:

• Checks that the hostname is specified for the MGC

• Checks that the login/password is specified for the MGC
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• Checks that MGC ipaddrs are specified

• Checks that if MGC failover is specified, then the failover IPs are specified

• Checks that the MGX hostname is specified

• Checks that the MGX login and password are specified

• Checks the MGX IPaddrs

• For EXTNODES where it refers to an MGX, checks PeerAddrs on IPLNK to ensure that they are 
addresses on the specified MGX

• For IPFAS IPLNKS:

– Ensures that SigSlot/SigPort are specified

– Checks SigSlot/SigPort on MGX to ensure that they are valid as specified on the MGX 

– Ensures that MGC ports and MGX ports match on the IPLNK

– Checks that all IPLNKs under a single IPFASPath map to the same port number

Note The number of IPFAS sessions utilizing a given port is displayed because some IPLNKs 
might use different port IDs.

Checking Traffic Against MGC Configuration
When you perform an integrity check of traffic against the MGC configuration, the VSPT does the 
following:

• When D channels are defined as FAS and NFAS PRI in the trunk group/trunk section, verifies that 
IPFASPath signaling services with corresponding IPLNKs are configured

• If IPFASPath signaling services defining a D channel are configured, checks that corresponding 
trunk group/trunk in the traffic information, and a corresponding NFAS/FAS PRI, is defined

• Checks that signaling services defined for trunk groups exist in the configuration

For information about an integrity check of dial plan results, refer to the Cisco Media Gateway 
Controller Software Release 7 Dial Plan Guide.

Use the following procedure to perform an integrity check of your configuration:

Step 1 On the main VSPT menu bar, click Tools > Integrity Check. The screen shown in Figure 3-47 appears.
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Figure 3-47 Integrity Check

Step 2 Indicate the tests you want to run, and click Start.

When the tests finish, a screen similar to the one in Figure 3-48 appears and displays the results of the 
integrity checks performed.

Figure 3-48 Integrity Check Results
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Viewing Generated MML
The VSPT application automatically generates the MML commands to provision your Cisco MGC and 
saves these commands in a file to be executed when you deploy the configuration. If you want to view 
the MML commands generated from your VSPT provisioning session, click View > MML. Screens 
displaying generated MML commands, similar to the one shown in Figure 3-49, appear.

Figure 3-49 First Generated MML Screen

Viewing Generated Cisco MGW Commands
To view the Cisco MGW commands generated from your provisioning session, click View > MGW 
Commands. A screen with generated Cisco MGW commands, similar to that shown in Figure 3-50, 
appears.
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Figure 3-50 Generated Cisco MGW Commands

Deploying a New Configuration
When you finish defining a configuration, you must deploy that configuration to the Cisco MGC. A new 
configuration should not be deployed during times of peak load on the Cisco MGC.

The new configuration can be deployed completely or in parts, known as an incremental deployment. 
Deploying incrementally allows you to verify each component type configuration before proceeding to 
the next component deployment.

The Cisco MGC does not support some incremental deployment processes. If you have problems with 
an incremental deployment, you should visually inspect the commands to ensure that you have properly 
configured the desired components. Modify those presenting the problem, or cancel the deployment and 
redeploy as a new configuration.

If you want to delete a component and plan to reuse the component name, delete the component, deploy 
the session, and verify that the component has been deleted before reusing the name.

Use the following procedure to deploy a new configuration:

Step 1 Click Tools > Deploy on the main VSPT menu. The screen shown in Figure 3-51 appears.
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Figure 3-51 Deploying a Configuration

Step 2 Enter the name for the configuration on the destination MGC.

Step 3 Select the configuration it is based on from the Based on configuration drop-down list. 

Step 4 To incrementally deploy a configuration component type, click Advanced. The screen shown in 
Figure 3-52 appears.

Figure 3-52 Incremental Deployment Component Selector

Step 5 Select one or more component types to deploy, and click OK.

Step 6 Indicate how you want to deploy the configuration:
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• If you want to send the configuration to the MGC but not activate it, click the button next to Send 
Configuration to MGC Only.

• If you want to send the configuration to the MGC and activate it, click the button next to Send and 
Activate Configuration.

• If you have a continuous-service configuration with two Cisco MGC hosts, click the button next to 
Send, Activate and Synchronize failover. The configuration is saved on the active host and copied 
to the standby host. You must restart the standby server after reconfiguration before the changes will 
become active.

• If you do not want to deploy to the MGC but only to MGXs, click the box next to Do not deploy to 
MGC.

Step 7 Select the gateways you want to deploy, if applicable.

Step 8 Click OK. A screen similar to the one shown in Figure 3-53 appears and displays the status as the current 
provisioning session is deployed.

Figure 3-53 Deployment Progress
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Note In a continuous-service configuration, the XECfgParm.dat file on each machine must be configured. 
If you experience problems, verify the XECfgParm.dat files on both machines. Refer to Chapter 2, 
“Installing Cisco Media Gateway Controller Software,” in Cisco Media Gateway Controller 
Software Release 7 Installation and Configuration Guide. 

Backup and Restore
The VSPT backup and restore tool enables a user to create, modify, and delete scheduled backups and 
restores hourly, daily, weekly, or monthly or on demand. Backup and restore activities can be performed 
on any of the following devices that have been configured for the MGC:

• MGC host—Active configuration

• CAT5500—Configuration and image on Flash

• CAT2900XL—Running-config and image on Flash

• SLT2600—Running-config and image on Flash

• BAMS P2—Active configuration

• BAMS P3—Active configuration

The backup and restore tool also provides the status of each activity and generates user-viewable status 
logs.

Note This tool operates in coordination with the MGC server operating system and can be used by only 
one UNIX login, specified during the installation process.

Schedule An Activity
Use the following procedure to open the VSPT backup and restore tool and schedule an activity:

Step 1 Click Tools > Backup and Restore on the main VSPT menu bar. The screen shown in Figure 3-54 
appears.
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Figure 3-54 Backup and Restore Utility

Step 2 Click the component for which you want to schedule a backup or restore. In the following example, the 
MGC is backed up. A screen similar to the one shown in Figure 3-55 appears when you click the MGC 
component.

Figure 3-55 Scheduling a Backup or Restore

Note If you want to perform a restore, a backup file must have already been created and must be available 
on the MGC.

Step 3 To schedule a backup or restore, highlight the component you want to back up or restore in the left pane 
of the main backup and restore tool window, and click Add. A screen similar to the one shown in 
Figure 3-56 appears.
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Figure 3-56 Schedule an Activity

Note The fields available here will vary according to the component you selected. 

Step 4 Select the action you want to perform in the Activity field. Valid choices include backup and restore.

Step 5 Enter the IP address of the Cisco MGC.

Step 6 Enter the MGC login and password.

Step 7 Enter a name for the backup file.

Step 8 Enter the IP address of the TFTP server.

Step 9 Enter the TFTP login and password.

Step 10 Specify whether or not to use verbose log mode. Verbose mode records all commands issued by the 
VSPT and any system responses.

Step 11 Select the schedule type. Valid choices include:

• Monthly

• Daily

• Hourly

• Weekly

• Now
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• Later

Step 12 Select the hour and minute that the backup should begin.

Step 13 Click OK. The backup activity is scheduled, and a screen similar to the one shown in Figure 3-57 
appears.

Figure 3-57 Display Activity Schedule

After the backup has been completed, the status of the activity is available immediately. The backup file 
with the name you specified is available for use with the VSPT to perform a restore.

Check Status of Backup or Restore

The VSPT generates status logs that provide information about each scheduled backup or restore 
activity. The status log displays the following information for the activity:

• Date and time 

• Success or failure

• File name on the TFTP server

• Directory of configuration files

• Image file name 

If you have specified verbose log mode, the status log also displays the sequence of commands issued 
by the VSPT and any system responses.

Use the following procedure to check the status of a backup or restore activity:

Step 1 Click the device that has been backed up or restored, in the left pane of the backup and restore tool 
window, and click the Status tab in the right pane. A screen similar to the one shown in Figure 3-58 
appears and shows the status of the activity.
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Figure 3-58 Backup and Restore Status Tab
.

Step 2 For more information or to delete the log file, select the appropriate button for the action you want to 
perform. Choices are:

• Show status—Displays the log file for the activity

• Acknowledge—Removes the text from the Status window and deletes the log file from the server

• Clear—Removes the text from the Status window, but the log file remains on the server 
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Provisioning the Billing and Measurements 
Server 

The Cisco Billing and Measurements Server (BAMS) provides enhanced billing and measurement 
functions corresponding to those found in a traditional Class 4 tandem switch. The BAMS server 
collects, formats, and stores billing and measurement data from the Cisco MGC. The data can then be 
processed by a billing system and other measurement collection and reporting systems. BAMS runs on 
a standalone server designed to interface with the Cisco  MGC. 

.Figure 4-1 provides an overview of the BAMS components.

Figure 4-1 BAMS Overview

The VSPT helps you create, copy, modify, and deploy a configuration for the BAM server. The BAMS 
provisioning session can exist as a standalone provisioning application using MML commands.

The VSPT performs the following tasks when you are configuring BAMS:

• Generates an MML batch file either from scratch or based on a preexisting configuration

• Imports and exports configuration information from and to a host

• Deploys the current configuration to a host

• Supports incremental deployment

• Displays the current MML batch file
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• Imports the TrunkGroup file from the Cisco MGC host to keep trunk group information 
synchronized

• Performs an integrity check to ensure that the current configuration check is valid

The steps necessary to provision a BAMS are:

• General provisioning

– Define country codes

– Define map types

– Define tollfree prefixes

• Zone provisioning

– Create zones in the Zone_Information table for separate rating zones

– Assign NPA-NXX prefixes to appropriate zones

– For each from/to zone pair, define the appropriate rating type for that zone pair

– Define rating exceptions in the rate-exception table

• Trunk group provisioning

– Configure trunk groups that map to trunk groups on the MGC. These trunk groups define the 
default originating and terminating NPAs and the number of circuits in a trunk group.

– Define a SigPath table for a dial configuration, because dial configurations have no trunk 
groups, routing files, or dial plans. Map SigpathID/bearer channelnumbers to trunk group 
number/member numbers.

• Measurements provisioning—Configure threshold alarms by means of the Threshold Crossing 
Alarms table (TCA-TBL).

Note VSPT Release 1.6 currently supports BAMS Phase 2 only. See the currentVSPT release notes for 
further information about future support for BAMS Phase 3.

Starting a BAMS Provisioning Session
Use the following procedure to provision a BAMS:

Step 1 Start and log in to the VSPT. The main VSPT window is displayed.

Step 2 Click File > Open on the main VSPT menu bar, to open an existing configuration, and go to Step5. If 
you want to start a new configuration, go to the next step. For more information, see the “Starting a New 
Provisioning Session” section on page 2-1.

Step 3 Click Tools > BAMS Config. The screen shown in Figure 4-2 appears.



 

4-3
Cisco Voice Services Provisioning Tool Release 1.6 User’s Guide

OL-1349-01

Chapter 4      Provisioning the Billing and Measurements Server
Starting a BAMS Provisioning Session

Figure 4-2 BAMS Configuration Screen

Step 4 Click File > New.

Step 5 Enter a name for the provisioning session you are creating. For more information on BAMS naming 
restrictions, refer to the Cisco Media Gateway Controller Software Release 7 Provisioning Guide. Click 
OK. The screen shown in Figure 4-3 appears.

Figure 4-3 New Configuration Wizard

Step 6 If you want to import an existing configuration from a BAMS, click the Import from BAMS radio 
button. Enter the host name, login, password, and the configuration you want to import. If you do not 
know the name of the configuration, click Select, highlight the configuration you want in the list that is 
displayed, and click OK.

If you want to manually configure the BAMS, select the Perform manual configuration radio button, 
and click OK. The screen shown in Figure 4-4 appears.
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Figure 4-4 BAMS Configuration

Step 7 Enter the BAMS IP address in the BAMS hostname field.

Step 8 Enter a the BAMS login ID and password.

Step 9 Enter the network addresses (IP Addr 1 and IP Addr 2) in dotted notation; for example, 172.18.145.3. 

Step 10 Click Modify, and begin BAMS provisioning.

BAMS Provisioning
This section provides directions for using the VSPT to provision a BAMS server. The VSPT performs 
the following procedures:

• Provisioning General Information, page 4-4

• Provisioning Zones, page 4-6

• Provisioning Trunk Group Information, page 4-10

• Provisioning Measurements, page 4-13

Provisioning General Information
Provisioning general BAMS information includes defining country codes, map types, and tollfree 
prefixes. Use the following procedure to configure general BAMS information:

Step 1 Click the icon next to General in the left pane of the main VSPT screen to expand the hierarchical tree.

Step 2 Highlight Country Codes, and click Add in the right pane of the main VSPT window. 

Step 3 Enter the country code and country name, and click OK. The screen shown in Figure 4-5 appears.
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Figure 4-5 Country Code Added

Step 4 Click Maptypes, in the right pane of the main VSPT window, and click Get Defaults in the left pane. 
The screen shown in Figure 4-6 appears.

Figure 4-6 Maptype Information Added

Step 5 Click Tollfree in the left pane of the main VSPT window, and click Add in the right pane. 

Step 6 Enter a tollfree code and click OK. The screen shown in Figure 4-7 appears.
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Figure 4-7 Tollfree Information Added

Step 7 If you want to configure more tollfree codes, click Add and repeat Step 6 for each code you want to 
configure.

Provisioning Zones

Note If you do not need BAF output, proceed to “Provisioning Measurements” section on page 4-13.

Zoning provides a mechanism for differentiating between rating types. Each supported NPANXX 
combination must be a member of a zone. 

Use the following procedure to provision zones:

Step 1 Click Zones > Identification, in the left pane of the main VSPT window, and click Add in the right 
pane. 

Step 2 Enter the zone number and description, and click OK. 

Step 3 Enter the zone number and description and click OK. The screen shown in Figure 4-8 appears.
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Figure 4-8 Zone Information Added

Step 4 Click Membership in the left pane of the window shown in Figure 4-8, and click Add in the right pane. 
The screen shown in Figure 4-9 appears.

Figure 4-9 Add Npanxx

Step 5 Enter the six-digit NPANXX numbers. You can enter several numbers by separating them with commas, 
for example, 123456,345678,567890. You can obtain A/Bdig numbers from the MGC by clicking Look 
up to display the dial plans defined on the MGC appears.

Step 6 Select a dial plan, and click OK. A screen displaying all A/Bdig numbers appears.

Step 7 Select one or more dial plans, and click OK.

Step 8 The screen shown in Figure 4-9 reappears. Enter the LATA, and select the zone. 

Step 9 Click OK. The screen shown in Figure 4-10 appears.
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Figure 4-10 Membership Information Added

Step 10 Click Relationships in the left pane of the window shown inFigure 4-10, and click Add on the right 
pane. The screen shown in Figure 4-11 appears.

Figure 4-11 Add Rating Type

Step 11 Select the origination zone, termination zone, and rate type. Indicate whether or not the relationship is 
bidirectional. If you select bidirectional, two entries are added to the table; otherwise, one entry is added. 

Step 12 Click OK. The screen shown in Figure 4-12 appears.
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Figure 4-12 Rating Type Information Added

Step 13 Click Exceptions, in the left pane of the window shown in ,Figure 4-12, and click Add in the right pane. 
The screen shown in Figure 4-13 appears.

Figure 4-13 Add Rate Exception

Step 14 Select the origination NPANxx, termination NPANxx, and rate type. Indicate whether or not the 
relationship is bidirectional. 

Step 15 Click OK. The exception is added, and the screen shown in Figure 4-14 appears.
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Figure 4-14 Exception Added

Provisioning Trunk Group Information
Provisioning trunk group information includes:

• Defining trunk groups that map to trunk groups on the Cisco MGC

• Specifying default origination and termination NPAs and the number of circuits in the trunk group

• Defining a SigPath table for dial configurations

Use the following procedure to provision trunk group information:

Step 1 Click the icon next to Trunk Group Info. in the left pane of the window shown in Figure 4-14, to expand 
the hierarchical tree. 

Step 2 Click Trunk Groups. The screen shown in Figure 4-15 appears.
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Figure 4-15 Configure BAMS Trunk Groups

Step 3 To import trunk groups from the MGC, click Import, and click OK at the confirmation prompt.

Step 4 Click OK. All trunk groups on the MGC are displayed in the trunk group screen.

Step 5 To add individual trunk groups, click Add. The screen shown in Figure 4-16 appears.

Figure 4-16 Add Trunkgrp

Step 6 Enter the trunk group, select the connection type, and enter the origination NPA, termination NPA, and 
circuits. 

Step 7 Click OK. The screen shown in Figure 4-17 appears.
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Figure 4-17 Trunk Group Added

Step 8 Click Sigpath. The screen shown in Figure 4-18 appears.

Figure 4-18 Configure a BAMS Sigpath

Step 9 You add a Sigpath only if the MGC is nailed up. You can import from the MGC by clicking Import.

Step 10 To add a Sigpath, click Add. The screen shown in Figure 4-19 appears.
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Figure 4-19 Add Sigpath

Step 11 Enter the Sigpath ID in hexadecimal, enter the number of bearer channels for this sigpath, select the 
trunk group number, and enter the starting trunk number. Click OK. The screen shown in Figure 4-20 
appears.

Figure 4-20 Sigpath Added

Provisioning Measurements
BAMS generates and maintains measurements, which are performance indicators that constitute a 
history of traffic statistics on a network. Each measurement value represents an accumulation of activity 
that took place during a specific interval.

Use the following procedure to configure measurement types and properties:

Step 1 Click the icon next to Measurements in the left pane of the main VSPT screen to expand the hierarchical 
tree. Click Thresholds. The screen shown in Figure 4-21 appears.
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Figure 4-21 Configuring BAMS Thresholds

Step 2 You can set thresholds for the item displayed in the drop-down menu next to VSCID/TRK/[IC]. Select 
a value from the drop-down menu next to the threshold you want to change. When you have finished 
setting thresholds, click Modify and all threshold configurations are saved.

Step 3 To add an item to the drop-down menu next to VSCID/TRK/[IC], click Add. The screen shown in 
Figure 4-22 appears.

Figure 4-22 Add TcaTbl

Step 4 Enter the VSCID, select the trunk group, and enter the carrier ID. 

Step 5 Indicate whether it should inherit from global/0. If you select inherit from global/0, you can then 
modify individual thresholds to meet your needs. 

Step 6 Click OK. The item you added is now accessible in the drop-down menu next to VSCID/TRK/[IC].

After the BAMS server is provisioned, you must deploy the new configuration. Refer to the “Deploying 
a New Configuration” section on page 3-61 for instructions.
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